# Table of Contents

## INSTALLING ROLL CALL
- Single User Installation ................................................................. 8
  - Mac users from the CD ................................................................. 8
  - Windows users from the CD ......................................................... 8
- Trial Version Roll Call Lite vs. Full Version ................................... 8
- Network Installation ........................................................................ 9
  - Installing the Server .................................................................. 9
  - Installing the Client ................................................................. 10
- Trial Version Roll Call Lite vs. Full Version ................................... 10

## GETTING STARTED
- Navigator ...................................................................................... 12
  - Navigator Menu .......................................................................... 12
- Top Menu .................................................................................... 12
- To Do List ..................................................................................... 12
- Birthdays ..................................................................................... 12
- Visitors ....................................................................................... 13
- Icons ......................................................................................... 14
- Search/Summary Screens .............................................................. 15
  - Customize ................................................................................. 15
- Find By ....................................................................................... 16
- Add or Delete Records ............................................................... 16
- Print .......................................................................................... 16
- Organization Info ......................................................................... 17
- License Number ........................................................................ 17
- Preferences ................................................................................. 17

## MAINTAINING PEOPLE INFORMATION
- Import People Information ............................................................. 20
  - One Row per Family (standard) ................................................. 20
  - One Row per Family (custom) ................................................... 21
  - One Row per Person (standard) ................................................. 21
  - One Row per Person (custom) ................................................... 21
- Import Process ............................................................................ 21
- Enter a new Family ..................................................................... 23
- Contact Information ................................................................... 24
- Address ..................................................................................... 24
- Pictures ..................................................................................... 25
- Phones ....................................................................................... 26
- Custom Fields ........................................................................... 27
- Dates ........................................................................................ 28
- Key Words ................................................................................. 29
- Comments ............................................................................... 30
- Add the Next Family Member ..................................................... 31
- Modify Family Relationships ...................................................... 31
  - Marriage ................................................................................ 32
  - Divorce ................................................................................... 33
  - Change HOF ............................................................................ 33
  - Death ..................................................................................... 36
CREATING CONTRIBUTION REPORTS

Donor Detail Report..............................................................107
Donor Summary Report..........................................................110
Donor Summary by Fund.........................................................113
Donor Giving by Week, Month or Year ......................................114
Top Donors..................................................................117
Donors over X Amount..........................................................119
Given X Times ................................................................121
Given 0 Times................................................................122
Fund Summary................................................................124
Fund Giving by Week, Month or Year .................................125
Contribution Detail ...............................................................127
Contribution Statistics...........................................................129

CREATING STANDARD AND CUSTOM LABELS

Standard Labels....................................................................132
Criteria ...............................................................................133
Options ...............................................................................133
Customize ..........................................................................134
View Records .....................................................................134
Which People ......................................................................134
Place the Fields on the Label ..............................................136
Static text ........................................................................137
Change Label Format and Size ...........................................137
Re-use the Label Template ................................................138
Modify a Label Template....................................................138

PRINTING DIRECTORIES

Classic Directory ................................................................139
Standard Directory ...............................................................140
Select the fields and format that will be displayed .................140
Select the people using associations .....................................141
Select the people using the query editor ..............................142
Select the people using associations .....................................143

USING THE QUERY EDITOR

Query Editor uses ...............................................................146
Table Layouts ....................................................................146
Address ............................................................................146
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate Security</td>
<td>172</td>
</tr>
<tr>
<td>Preferences</td>
<td>173</td>
</tr>
<tr>
<td>Create New User</td>
<td>173</td>
</tr>
<tr>
<td>Security Levels</td>
<td>174</td>
</tr>
<tr>
<td>Recover the database</td>
<td>177</td>
</tr>
<tr>
<td>From within Roll Call</td>
<td>177</td>
</tr>
<tr>
<td>Backup a networked system</td>
<td>177</td>
</tr>
<tr>
<td>From the operating system</td>
<td>178</td>
</tr>
<tr>
<td>Recover database from a backup on a network system</td>
<td>181</td>
</tr>
<tr>
<td>Open a Different Datafile</td>
<td>182</td>
</tr>
<tr>
<td>Compact the data file</td>
<td>182</td>
</tr>
<tr>
<td>Single user system</td>
<td>182</td>
</tr>
<tr>
<td>Roll Call Server</td>
<td>182</td>
</tr>
<tr>
<td>Repair my data file</td>
<td>183</td>
</tr>
</tbody>
</table>
INSTALLING ROLL CALL

Single User Installation
The single user version of Roll Call allows one user, on one computer to access Roll Call. For the single user installation, use the following instructions.

Mac users from the CD
To install Roll Call from the CD, simply place the CD in your CD drive. A By the Book disk image will be displayed on your desktop. Double click on that image. There will be three Roll Call files: 1) Roll Call 2) Roll Call Client and 3) Roll Call Server. Double click on the Roll Call file. The install program will prompt you through the process. Click on the NEXT button to continue through each step of the process.

Windows users from the CD
To install Roll Call from the CD, simply place the CD in your CD drive. There will be three Roll Call installation files: 1) Roll Call 2) Roll Call Client and 3) Roll Call Server. Double click on the Roll Call file. The install program will prompt you through the process. Click on the NEXT button to continue through each step of the process.

Once the installation is complete, you will have a Roll Call icon on your desktop. To use Roll Call, double click on that icon.

From the download file
To install Roll Call from the downloaded file, double click on the Roll Call installer file you downloaded. The install program will prompt you through the process. Click on the NEXT button to continue through each step of the process.

Once the installation is complete, you will have a Roll Call icon on your desktop. To use Roll Call, double click on that icon.

Trial Version Roll Call Lite vs. Full Version
After you launch Roll Call you will see a message allowing you to choose the option of Roll Call you wish to demo. Simply select the option RC Lite or Full Version. If you decide you would like to demo both, you will need to go to File>Enter license from the trial you are currently using and reselect your new option. Roll Call will then automatically close. You will need to re-launch Roll Call by double clicking on the icon. Roll Call will then proceed with the version demo that you had selected.
Network Installation

A network installation of Roll Call allows multiple people to access the data. If you have a multi-user license, multiple users can access the data simultaneously. For example, if you have purchased a 3 user license, 3 users may access the database at the same time. If you have purchased a single user license, you may still install the network version, but only one person may access the data at a time.

First you must decide which computer will house the database. That computer will be your server. The computer you choose as your server should not be used for many other applications. For example, if your secretary’s computer is used for creating the bulletin, writing letters and accounting, you probably wouldn’t want her computer to be your Roll Call Server. Since the server needs to be running at all times, it would slow down her other work.

Next decide who will need to use Roll Call. Each of those users will need Roll Call Client installed on their computer.

Installing the Server

To install Roll Call Server from the CD, simply place the CD in your CD drive. For Windows users there will be three Roll Call files: 1) Roll Call 2) Roll Call Client and 3) Roll Call Server. For Mac users the By the Book disk image will be displayed on your desktop. Double click on that image. Next, double click on the Roll Call Server file. The install program will prompt you through the process. Click on the NEXT button to continue through each step of the process.

To install Roll Call Server from the downloaded file, double click on the Roll Call Server installation file. The install program will prompt you through the process. Click on the NEXT button to continue through each step of the process.

Once the installation is complete, there will be a Roll Call Server icon on the desktop. To start Roll Call Server, double click on the icon. The Roll Call Server window will be
displayed. For users to work in Roll Call the Server must be running.

**Installing the Client**

To install Roll Call Client from the CD, simply place the CD in your CD drive. For Windows users there will be three Roll Call files: 1) Roll Call 2) Roll Call Client and 3) Roll Call Server. For Mac users, a By the Book disk image will be displayed on the desktop. Double click on that image. Next, double click on the Roll Call Client file. The install program will prompt you through the process. Click on the NEXT button to continue through each step of the process.

To install Roll Call Client from the downloaded file, double click on the Roll Call Client installation file. The install program will prompt you through the process. Click on the NEXT button to continue through each step of the process.

Once the installation is complete, there will be a Roll Call Client icon on the desktop. To start Roll Call, double click on the icon. If this is the first time this client has connected to the Roll Call Server, you may get a -1002 error. If this happens, just click through the message. Then you will get a window that has 3 tabs: Recent, Available and Custom. Click on the Available tab. You should see Roll Call listed there. Highlight it and click OPEN.

**Trial Version Roll Call Lite vs. Full Version**

After you launch Roll Call you will see a message allowing you to choose the option of Roll Call you wish to demo. Simply select the option RC Lite or Full Version. If you decide you would like to demo both, you will need to go to File> Enter license from the trial you are currently using and reselect your new option. Roll Call will then automatically close. You will need to re-launch Roll Call by double clicking on the icon. Roll Call will then proceed with the version demo that you had selected.
If you want to change the demo version, go to File>Enter License. Then, select the new version you wish to demo.

![Enter License dialog box](image)

This trial version of ROLL CALL is fully functional until 1/19/2012.

Leave the license blank until you receive a valid number.
GETTING STARTED

Navigator

When you start Roll Call, the Roll Call home screen will be displayed in the Navigator Window. The main sections of the navigator are discussed below:

Navigator Menu

The main menu items for Roll Call are found on the left side. If there is an arrow, pointing to the right, there are sub menus underneath that item. Click on the arrow to expand that menu. If an arrow is pointed down, click on it to collapse the menu items. If there is no arrow in front of the menu item, click on it, to perform that function.

Top Menu

Additional menu items can be found across the top of the Navigator Window. These menu items are typically administrative type items, for example, backups, maintenance, and imports. Click on the name of the menu, then move the mouse and select.

To Do List

Each Roll Call user will have a To-Do list displayed on the Home page. To add an item to your To-Do list, click on the plus sign (+) in the lower corner of the area. A window will be displayed for you to enter the task. To mark an item as completed, click on the box in front of the item. To delete items from the list, highlight one or more items, then click on the minus (-) sign in the lower part of the area. To print your To-Do list, click on the printer icon.

Birthdays

The birthday section of the Home page will show you who has a birthday this week, next week, this month, or next month. Use the drop down to choose which time frame you are interested in.

Each Roll Call user, can set their own preferences for this birthday list. For example, the children’s ministry leader may only want to see kids who are in the Sunday school classes.
in her list. While a deacon, who is the shepherd for several families, would only want to see the birthdays for the people he is responsible for. To set this preference, click on the Pref icon underneath the birthday area.

Choose the time frame for birthday list.

Set preferences for which people you want in the list.

Print the birthdays.

To print the birthdays, click the print icon underneath the birthday section. The information displayed in this report is based on what is selected for the birthday report. See the chapter on Reporting on People.

**Visitors**

The visitor section outlines anyone with an association of “Visitor”, who attended or gave last week. To set the preferences for which attendance or contributions to consider, click on the Preferences icon in the lower right corner.

Choose activity date.

Click preferences to choose what activity to consider.

**Church Logo**

If you would like to display your church logo on the Home page instead of the Roll Call logo, select File>Import Logo from the top menu. A “look in” window will be displayed. Navigate to your image file and open it. For the best network performance, this should be a small file.
Icons

There is a standard set of icons you will see on each main Roll Call screen. They allow you to perform many common functions such as printing, querying, saving a set, etc. These icons are listed below.

- The **printer** icon allows you to print the list that is displayed on your screen. For example, if you were in the people search screen you would get a list of all the people that are in your current list.
- The **email** icon allows you to send an email or text all the people in the current list.
- The **write a letter** icon allows you write a mail merge letter to the people in the current list. If you are in an individual’s record, you can write a letter to them.
- The **label** icon allows you to print mailing labels (Avery 8160) for the people in your list.
- The **spreadsheet** icon allows you to put the information displayed on your screen in a spreadsheet program.
- The **show all** icon displays all records when pressed.
- The **sort records** icon allows you to sort the information in your list by any of the fields in your list.
- The **search records** icon allows you to perform a query of the database.
- The **special search** icon allows you to perform a predefined query, like finding the heads of the families listed.
- The **compare sets** icon allows you to perform a comparison of two results sets. For example, who are my donors that are also in a small group.
- The **save set** icon allows you to save the results of a query.
- The **get set** icon allows you to retrieve the results of a previously saved set.
- The **subset** icon allows you reduce your list to only those records that are highlighted.
The preference icon allows you to set user specific criteria based on the window you are currently in. From the search windows, the preference icon will allow you to choose which columns to display.

Search/Summary Screens

Each of the main functional areas of Roll Call will have a Search menu item. These Search or Summary screens can be used to find records, correspond with people and add new records.

Customize

Each Roll Call user can choose which fields they’d like displayed on a Search screen. To select the columns, do the following:
1. Click on the Search menu item for the area you are interested in.
2. Click on the Preferences icon.
3. Move the columns you’d like displayed from the left side to the right side. You can either drag and drop, double click or highlight the field and click the arrow to the right.
4. To modify the ordering of these columns, drag the field name to the position in the list.
Find By

When you first select a Search menu item, all records will be displayed in the window. To find specific records, you can use the Find By option. Use the Find By drop down to select the criteria you are interested in. Next enter the value for the criteria you are searching for.

Add or Delete Records

Notice the plus and minus buttons (+/-) in the lower left of the Search window. Use these buttons to add new records. Or highlight one or more records and click the minus sign to delete those records.

Print

To print the information that is displayed in your Search window, simply click on the PRINT icon. A report will be printed that contains that same information.
**Organization Info**

When you first begin using Roll Call, you will want to set up your Church or Ministry information. To do this, click Organization from the Navigator menu on the left. Enter the following information:

1. **Organization Name** – Enter the name of the church or organization
2. **Main Address** – Enter the street address for the church or organization
3. **City** – Enter the city where the church or organization is located
4. **State** – Enter the state where the church or organization is located
5. **Zip Code** – Enter the postal code for the church or organization
6. **Country** – If not in the US, enter your country here
7. **Tax ID** – Enter your tax id. This is used on Canadian donation receipts.
8. **Main Phone** – Enter the main telephone number for the church
9. **Main Fax** – Enter the fax number for the church
10. **Website** – Enter the web address for the organization
11. **Current Fiscal Year** – Enter the starting date of the current fiscal year

Enter your church information. This will be the return address on year end receipts.

Make sure to click SAVE before you navigate to other menu items.

**License Number**

When you purchase Roll Call, you will be given a *License Number*. You will need to enter that number into Roll Call. To do that select File>Enter License from the top menu. Enter your number and press the tab key. The number of users and number of allowed records will be filled in for you. Click OK to save the number.

**Preferences**

The preferences area allows you to define certain characteristics of Roll Call functionality. For example, do you require multi-campus functionality, do you wish to default the address to the same city, state and zip as the church, etc. To modify the preferences, go to the top menu and select Edit>Preferences (on Windows) or select RollCall>Preferences (on Mac).

**People Preferences**

The following information can be set under the People tab of the Preferences screen.

1. **Optional Mailing Name Autofill** - Mark yes if you would like the first and last name of the person to be automatically filled into the Optional Mailing Name field.
2. **Last Comm Date** - Choose which name you’d like for the date field underneath Wedding date.
3. **Family Numbers** - Mark if you’d like family numbers to be automatically or manually generated.
4. **Family Position** - Mark at what ages children should change from Child to Youth and from Youth to Adult. Do you want the system to automatically change this position on their birthdate?

5. **Security Clearance Level** - Mark if you’d like to use this field.

6. **Multiple Campus** - Does your church have multiple campuses? If so mark yes here to add a campus field to the people and group screen.

7. **Custom Fields** - Use the custom tab under the People tab to define the field, checkbox and date custom field names. These field names will be used in the People screen under the custom tab.

---

**Choose the options that apply to your church.**

---

**Address Preferences**

The following information can be set under the Address tab of the Preferences screen.

1. **Default Address** - Mark if you would like the city, state or zip from the church address to be the default city, state and zip for the people you enter into the system.

2. **Country** - Mark if you’d like to display a country field in the People screen.

3. **Web Maps** - If you’d like to use a different web map, enter the URL and syntax required.

---

**Contribution Preferences**

The following information can be set under the Contribution tab of the Preferences screen.

1. **Default Designation** - Enter the default fund name for entering contributions.

2. **Pledges** - Select which pledges you’d like to see on the donation entry screen.

3. **Connect Pledges** - Indicate if you want to connect contributions to incomplete pledges or just the current pledge.

4. **Print Receipt** - Indicate if you’d like to print a donation receipt immediately after entering a contribution.
Enter your default fund name.

Indicate how you’d like to handle pledges.

Attendance Preferences (not usable in RC lite)
Under attendance preferences you can select the default information that will be included on the bar code badges used for child check in.

Group Custom and Member Custom Preferences (not usable in RC lite)
The group custom and member custom preferences allow you to set up templates for certain group types. For example if you have a group type of “small group” and you want to set up custom fields for every group that is a small group, use these fields.

In our small group example, let’s say we want to track what they are studying and if they are accepting new members. These fields are considered group custom fields because that is information about the group as a whole. If we also want to track for every member of a small group, their Tshirt size and Bible Knowledge Level, these would be considered member custom fields.
MAINTAINING PEOPLE INFORMATION

Import People Information
When you begin using Roll Call, you may wish to import your existing contacts into the database. Roll Call allows you to import people contact information and some custom fields from a tab delimited text file. If you have the information in Excel, you can create the tab delimited file, by saving as “tab delimited text file”.

There are four file variations that can be used for the import:

One Row per Family (standard)
This format assumes that all the information on a single line is for one family. The data must be in the following order:
1. Family Last Name
2. Head’s First Name
3. Gender
4. Association
5. Cell Phone
6. Work Phone
7. Email
8. Spouse Last Name
9. Spouse First Name
10. Spouse Gender
11. Spouse Cell
12. Spouse Work Phone
13. Spouse Email
14. Home Phone 1
15. Home Phone 2
16. Address 1
17. Address 2
18. City
19. State
20. Postal Code
21. Child 1 First Name
22. Child 1 Gender
23. Child 1 Birth date
24. Child 2 First Name
25. Child 2 Gender
26. Child 2 Birth date
27. Child 3 First Name
28. Child 3 Gender
29. Child 3 Birth date
30. Child 4 First Name
31. Child 4 Gender
32. Child 4 Birth date
33. Child 5 First Name
34. Child 5 Gender
35. Child 5 Birth date
One Row per Family (custom)
This format allows you to import the same information, names, children, address, city state, zip, gender and birthdates, but the order does not have to be exact. For example if you don’t have a second home phone, you don’t need to leave a blank column for that field. You will be able to tell Roll Call which data is in which column.

One Row per Person (standard)
In the one row per person format, each row in the spreadsheet represents an individual. Roll Call will pull people together based on matches in the address field. The first person it encounters with an address will be marked as the head of family.

This file type requires the data to be in this exact order. If you do not have data for a column, leave that column blank.
1. Title (ex. Mr., Mrs., Rev etc.)
2. Last Name
3. First Name
4. Nick Name
5. Suffix (ex. Jr., Sr.)
6. Gender (Male or Female)
7. Family Position (Husband, Wife, Youth, Child, Adult or Other)
8. Marital Status
9. Association (ex. Member, Regular Attender, Visitor)
10. Email
11. Home Phone 1
12. Home Phone 2
13. Address 1
14. Address 2
15. City
16. State (2 character abbreviation)
17. Postal Code
18. Birth Date
19. Cell Phone
20. Work Phone

One Row per Person (custom)
In the one row per person format, each row in the spreadsheet represents an individual. Roll Call will pull people together based on matches in the address field. The first person it encounters with an address will be marked as the head of family.

In the custom format, the columns can be in any order you choose. This format also allows you to import custom fields. As part of the import process you will be able to define which data belongs to which fields.

Import Process
Once you have created the file that will be imported, do the following to bring the data into Roll Call.
1. Expand the People menu on the left side.
2. Click on Import People (You can also select File>Import People from the top menu).
3. From the window that is displayed, select your file format type, click NEXT.
4. From this window, select your default Association and default Family Position. These fields are required, so if you don’t have a value in the record, Roll Call will use the default value to create the record in Roll Call.
5. Indicate which row the data starts. For example if you have titles in row 1, the data would start on line 2.

6. Click LOAD FILE. Navigate to your text file and open it. Your data will be displayed in a spreadsheet fashion in the lower section of the window.

7. If you selected a custom file format, you will need to use the drop down box at the top of each column to define the data represented in that column. If you do not want to import the data in a column, leave the selection as SKIP.
Enter a new Family

To enter people information into Roll Call using the Add Person screen you can do either of the following:
1. From the Search Profiles (under People), click on the plus (+) sign in the lower left.
2. OR, Open up the People menu (left sidebar) and click Add a Family.

You are now in the Add Person screen. If you are entering a new family, enter the person who will be marked as Head of Family first. When you first come into the form, you’ll be in the Family Position field. Based on your selection here, the Title, Gender and Marital Status can be filled in.

Once you enter family position, the title, gender and marital status will be filled in for you.

Enter name and contact information.
Contact Information

Once you’ve entered the Family Position, you can tab through each of the fields on this main page. Enter the following information:

1. First Name - enter the person’s full first name.
2. Nickname - the nickname will default to the value entered for the first name. You can change this to the nickname if it is different than the first name.
3. Middle Name – enter the middle name. This field is not required.
4. Last Name – enter the last name. This field is required. If you are entering a business, enter the business name in the last name field.
5. Suffix - enter the suffix Jr., Sr., etc if applicable.
6. Spouse - if the person you are entering is married, you can enter the spouse’s name here.
7. Association – enter how this person is involved in the church. Are they a Member, Regular Attender, Visitor, etc.
8. Birth Date - enter the full birth date for the person.
9. Primary & Alt Phones - enter the phone numbers for the family here.
10. Unlisted - if the family doesn’t want their phone numbers listed in directory check here.
11. Head of Family – this box will be checked for the head of family. Each family needs one and only one head.
12. Personal Email – an email address for this person.
13. Envelope Number – you may enter an envelope numbers here, or use the assign envelope number option under the Bulk Changes menu to assign numbers en masse.
14. Family Number – if you selected “automatic” from preferences, this number will be assigned by Roll Call. Otherwise, you may assign a family number manually.
15. Badge No. - if the family position is child, a badge number will be assigned. You may enter a different number if you’d like.
16. Barcode No. – the barcode number is used to identify individuals and families for child check-in. This number is automatically assigned by Roll Call, unless you have the preference set to manually assign the number.

Address

Next, we’ll move down to the address/pictures tab on the People screen. Notice there are three tabs underneath Address. You can now click on the tab to enter Primary Address, Alternate Address and Notes. The Primary address is the families main address. The Alternate address if for folks who live in a different part of the country for part of the year. The notes section can be used to enter driving directions.

Enter the following information on the Primary address tab:

1. Optional Mailing Name - The name entered here will be used as the mailing name on all correspondence and labels. For example, if you have a husband and wife Jim & Sue Smith, the default mailing label would be Jim & Sue Smith OR Mr. & Mrs. Smith. However, if you entered “The Smith Family” as the optional mailing name, the letters, labels and receipts would be addressed to “The Smith Family”.
2. Address, City, State and Zip.
3. Country – if you have the preference turned on for country there will be a country field displayed here.
4. Shepherd Area – if your church assigns deacons, congregational care pastors or other lay people to come along side families, you may indicate that here.
5. Family Email – an email address that can be used to send emails to the entire family.
6. Bad Address – if you’ve had mail returned, so you know it is an invalid mailing address, you can mark the box for “bad address”.

24
7. Do not send mail – if someone has requested that you not send them mail, mark this box.
8. Unlisted Address – if someone has requested that their address is not published, mark this box.

If you need to enter a secondary or alternate address, click on the ALT Address tab. Enter the following information:
1. Address – the street address for the alternate address.
2. More Address – the address line 2.
3. City, State and Zip of the alternate address.
4. Country – if you have the preferences to display country, you can enter the country here.
5. Phones – enter the home phone numbers for the alternate location.
6. Effective Month & Days – enter the start date when this address takes effective.
7. Ends Month & Day – enter the moth and day that this address should no longer be used.

To enter Notes regarding the address information, click on the Notes tab. Enter the free format information here.

If you’d like directions to an address, click on the WEB MAP button on the bottom of the page. If you’d like to copy the address onto the clip board to paste in another application, click COPY ADDRESS.

Pictures
You can pull in family pictures and/or individual pictures into Roll Call. Click on the Address/Pictures tab. Notice the two tabs on the right side for Picture and Family Picture.

The individual picture should be a portrait picture. To pull in the individual picture do the following:
1. Make sure you are anchored on the Picture tab (click on the word Picture).
2. Click on the plus sign (+) in the lower left.
3. Navigate to your image file and click OPEN.

The family picture should be in landscape. To pull in the family picture do the following.
Click on the tab for the type of picture you are bringing in.

To navigate to the image file, click on the plus sign.

1. Make sure you are anchored on the Family Picture tab (click on the word Family Picture).
2. Click on the plus sign (+) in the lower left.
3. Navigate to your image file and click OPEN.

Phones
To enter an individual’s phone numbers, click on the Phones tab. Enter the following information:
1. Work Phone & Extension – enter the person’s work number.
2. Cell Phone – enter the cell phone number for this person.
3. Pager – enter a pager number for this person if they have one.
4. Fax – enter a fax number for this individual.
If an individual has multiple cell numbers or emergency numbers or additional phone numbers you’d like to record, use the Additional Phones section to enter these numbers. To enter these numbers, do the following:
1. Click the plus sign (+) in the lower left.
2. Enter the Phone Number.
3. Enter an Extension if applicable.
4. Select the Description of the phone from the drop down, or enter a new one. For example is this an emergency number, secondary cell, etc.

**Custom Fields**

The custom fields in the People screen allows you to track information about a person that we don’t have as a standard field in Roll Call. The following are all good examples of custom fields that can be set up in Roll Call: a person’s occupation, whether or not they want to receive emails or a baptism date.

To define the custom fields that you will track for each person, do the following:
1. Click on the Custom tab.
2. Click on the CHANGE TITLES button.
3. Select the type of field you are defining… field (text), check box (yes or no) or dates.
4. Name the field.
To enter the data for a person, do the following:
1. Click on the Custom tab.
2. Click on the sub tab for either Custom Fields or Custom Check Box.
3. Enter the values applicable for this person.

**Dates**
The Dates tab can be used to enter the *Anniversary date* for married couples as well as custom dates that you define. See the Custom Field section for instructions on defining date custom fields.

This section can also be used to enter *Significant Dates*. Significant Dates are events that happen to an individual that you may wish to track so that you can follow up with this person on the anniversary of the event. Good examples of significant dates would be the death of a family member or diagnosis of cancer.

To enter significant dates into the system, do the following:
1. Click on the Dates custom tab
2. On the right portion of the tab, click on the plus sign (+).
3. Enter the *Date* of the event
4. Enter the description of the *Significant Date*.
**Key Words**

The Key Words area allows you to categorize folks. Good examples for key words would be tracking volunteer interests, spiritual gifts and talents. Once you have assigned a keyword to people, it is very easy to get a list of all the people that are “prayer warriors” or “mechanics” etc.

To enter a keyword for an individual, do the following:

1. Click on the Keyword tab.
2. Click the plus sign (+) in the lower left of the window.
3. If applicable, enter the relevant *Date* for this keyword.
4. Enter the *Keyword*. Select a value from the drop down list. If the value you need is not in the list, simply type the keyword and you’ll be asked if you want to add it to the list.
5. Enter the *Rank*. The rank could be from a survey… how interested are they in volunteering in the nursery.
Comments

There are several types of comments that can be tracked within Roll Call. The General comments would be a comments section that all Roll Call users can see. General comments also include a field for Special Needs and Allergy information. The Custody comments allow you to enter any restraining order type information. This will be displayed in the child check in system on check out. The Confidential comments can only be entered and viewed by users that have the appropriate security access in Roll Call.

To enter general comments, do the following:
1. Click on the Comments tab.
2. Click on the General tab underneath the Comments tab.
3. Enter your general Comments.
4. Enter any Special Needs or Allergy information in the right field. This information will be printed on the Sign in Roster and on the Name Tag for children.

To enter custody information, do the following:
1. Click on the Comments tab.
2. Click on the Custody tab underneath the Comments tab.
3. Enter the Custody information.

To enter confidential comments, you must have the proper security access to enter or view this information. If you don’t have access, you won’t even see the tab. To add a confidential comment:
1. Click on the Comments tab.
2. Click on the Confidential tab underneath the Comments tab.
3. Click the plus sign (+) on the left portion of the window.
4. Enter the Date of the comment.
5. Enter the Comment.
Add the Next Family Member

Once you have added all the information for an individual, you can do several things:
1. Click SAVE & CLOSE. This will save the information you entered, and return you to the Search People window.
2. Click SAVE & NEW, then select ADD NEW FAMILY MEMBER. This action will save the information you just entered. You will be taken to the People Information window, with the family information displayed. At this point you can start entering the information for the wife, children or other family member.
3. CLICK SAVE & NEW, then select ADD NEW FAMILY. This option saves the information you just entered. Then you will be taken to the People Information window to begin entering a completely new family.

Modify Family Relationships

Once you’ve entered the people of your parish or congregation into the system, there are life events that can cause family relationships to change: birth of a child, marriage, divorce or a death in the family. This next section discusses how to make changes in Roll Call for each of these events.

Addition to the Family

To add children (or others) to an existing family, do the following:
1. Open up the People menu on the left side.
2. Click on Search Profiles.
3. Find a person from the family you need to add to, and double click on their record.
4. Click the SAVE & NEW button.
5. Choose the option for ADD NEW FAMILY MEMBER.
6. You will be taken to the People Information window, with the family information displayed. At this point you can start entering the information for the new family member.
7. Click SAVE & CLOSE to save the information for the new family member and return to the Search window. Or click SAVE & NEW to enter another family member.
Marriage

When folks get married, their records need to be combined into one family unit. The different scenarios include:
1. The husband/wife is in Roll Call, but the other is not.
2. Both the individuals are in Roll Call.
3. The husband or wife has children as part of their family.

To handle the situation where one is in the database and the other is not, do the following:
1. Open up the People menu on the left side.
2. Click on Search Profiles.
3. Find the individual (husband or wife) who is in your database.
4. Click the SAVE & NEW button.
5. Choose the option for ADD NEW FAMILY MEMBER.
6. You will be taken to the People Information window, with the family information displayed. At this point you can start entering the information for the new family member.
7. Click SAVE & CLOSE to save the information and return to the Search window.

To handle the scenario where both the husband and wife are in Roll Call, do the following:
1. Pull up the new wife’s record.
2. Click on the Head of Family check box.
3. Select the option for “Make this person member of another family”.
4. Enter the Last Name of the husband.
5. Click OK.
6. A list of people with that last name will be displayed. Double click on the appropriate person.
7. The wife is now part of the husband’s family. You’ll need to manually change the Marital Status and Family Position. You may also enter the spouse name in the Spouse field if you choose.

The final scenario would be a blended family. For this example, let’s say we have a family of four that was entered as two separate families. One family has the husband and a child. The other family has the wife and another child.
1. Pull up the wife’s record.
2. Click on the Head of Family check box.
3. Select the option for “Make this person member of another family”.
4. Enter the Last Name of the husband.
5. On the right hand side of the screen, highlight the child’s name to indicate that you’d like to move the child as well.
6. Click OK.
7. A list of people with that last name will be displayed. Double click on the appropriate person.
8. The wife and child are now part of the husband’s family. Check that the Marital Status and Spouse name are correct for the husband and wife’s record.
Divorce
In the case of divorce you will need to separate the husband and wife into two separate families in Roll Call. To do this:
1. Pull up the wife’s record.
2. Click on the Head of Family check box.
3. Select the option for “Make this person head of a new family”.
4. On the right hand side of the screen, highlight any children who will be staying with mom.
5. Mark the Retain Address box, if the wife is staying at the current address.
6. Click OK.
7. The wife is moved into a new family with any children that were marked. Make sure you enter her new address if she is not staying at the current address. Also change the Marital Status, Family Position and Spouse Name for both the husband and wife.

Change HOF
If you imported people into Roll Call, or used child check in to enter children’s names into the database and now realize the wrong person is marked as the Head of Family, this can be changed. To change who is marked as the HOF, do the following:
1. Pull up the record for the person you want to be the HOF
2. Click on the Head of Family check box.
3. A window will be displayed. Mark “make this person the head of the current family”
4. Click OK.
Notice David and Nikki are now in the same family.

Make sure to update marital status, titles, gender and last name.

From the wife’s record, click on the Head of Family checkbox.

Select option for Make member of another family.

Enter the Last Name of the husband, highlight the children that are moving to the new family, then click OK.
Notice we now have both Nikki and kids are in David’s family.

Mark to make her the head of a new family.

Highlight children moving with mom. Click OK.

Notice Nikki & kids are now in a separate family.

Make sure to change marital status and family position.
Delete People from the Database

People who have not made contributions can be deleted from Roll Call. To delete records you can do it from the People details screen or the Search window.

To delete a person from the People details screen, do the following:
1. Click on the Search Profile menu, under People.
2. Find the person you wish to delete.
3. Double click on the record to view the details.
4. Click the DELETE button in the bottom right of the window.

To delete a person from the Search screen, do the following:
1. Click on the Search Profile menu, under People.
2. Find the person or people you wish to delete.
3. Highlight their records. To highlight one or more, hold down your CTRL or CMD.

Death

If a person within a family dies, we recommend that you change their Association to “Deceased”. If the deceased is the Head of the Family and donations were recorded for him, transfer the donations to the surviving spouse. To ensure that he is not included in the directory or in any mailings, split him out into a separate family.

To change the association:
1. Pull up the deceased’s record.
2. Change Association to “Deceased”.

To transfer the donations:
1. Click on the contributions tab.
2. Use the drop down and select Details by Week.
3. Right mouse click and select Transfer.
4. A Find Person window will be displayed to allow you to choose who to transfer these donations to. Enter a last name. Select from the list.

To move into a separate family:
1. Click on the Head of Family check box or select Additional>Change HOF from the menu bar at the top of the people screen.
2. Select the option for “Make this person head of new family”.

At the end of this process, you have retained a record of the deceased person. His donations have been transferred to the spouse, so she will receive the year end contribution statement and all correspondence will be addressed to her.
In husbands record, go to Contributions tab. Click on Detail by Week view.

Right mouse click on detail side, click Transfer. Use the Find Person window to find the person to transfer to.

key while clicking on the record.

4. Click the minus sign (-) in the lower left of the window
4. You are now in the Background Check entry screen. Enter the Last Name of the person that the background check is for. Press tab, and a list of people with that last name will be displayed. Select the appropriate person from the list.
5. Enter the following information:

Pull up the record for the person you wish to delete, click DELETE.
Highlight the people you wish to delete, click the minus sign.

This screen allows you to review a list of the people who will be deleted. Anyone with contributions will be in red.

Click to delete all.

A log of all deletions.

Processing bulk deletes on: 4/26/11 - 10:09:21
Deleting Kim Conley 9479 N Woodgate Byron IL 61010...Successful
Deleting David Conklin 418 W Blackhawk Byron IL 61010...Successful - Taylor Conklin marked as n
Processing completed.
FINDING PEOPLE

Search Profile Window

To find records in Roll Call, use the Search window. To find specific people, expand the People menu, then click Search Profiles. There are several main sections of the Search window:
1. The icon bar.
2. The Find By drop down and criteria.
3. The results.
4. The add and delete buttons.

Icon Bar

Note the icons across the top of the Search window. These icons allow you send emails, write letters or create labels for the people that are in the list. You can also print the list, do more detailed queries or do special searches. For more information on these icons, see the Getting Started – Icons chapter.

Find By

Note the drop down box to the right of “Find by”. Use this drop down to choose the criteria you’d like to use to find specific records. The field to the right allows you to enter the value you are looking for.
Results

As you type in the value you are looking for, the result set will change. For example, if you choose to find by “last name”, and start entering Crumb, when you type in C, you’ll get a list of all names that start with C. As you type “c”, the list will be reduced to those last names that start with “Cr”.

From the results list, simply double click on a record to view the detail information for that person.

Add/Delete

In the lower left of the results section, notice the plus and minus (+/-) signs. Click on the plus sign to add a new record. Click on the minus sign to delete records from this list.

Customize Search Window

The Search window for People shows the following information: Last Name, First Name, Head of Family checkbox, Association, Family Position, Individual Email, Home Phone, Address 1, City, State and Postal Code.

If this information is not all displayed on your screen, you can use the scroll bar at the bottom of the window to view information that is off the screen. If you have a larger monitor, you can drag the lower right corner of the window to enlarge it.

Each Roll Call user can set preferences for what fields they’d like displayed in the Search window. To change the display fields:
1. Click on Prefs icon.
2. Drag a field from the left side to the right side.
3. To re-order the fields, drag the field up or down on the right side.
4. Click SAVE & CLOSE to save changes.
Find Specific Records

Find By Criteria
To find people by Last Name, First Name, Association, Family Position, Email, Street, City, Postal Code, Family No, Badge No, Envelope or Keyword you can select that criteria from the Find By drop down box. Once you’ve selected your criteria, enter the value you are looking for in the field to the right. The results will be displayed below.

Select your Find By criteria. How do you want to find this person?

Enter the value you are looking for.

Search Window
If you are searching for people by their Last Name or by a Keyword, use the Search box on the right side of the screen. Enter the name or keyword, then press Enter. Your results will be displayed.

Enter last name or keyword in search box, then press ENTER.
Query Editor

If you need to search for people by a field that is not listed in the Find By drop down box, you will need to use the query editor. To use the query editor, do the following:

1. Click on the SEARCH icon.
2. Select a field from the Field drop down box on the left side of the window.
3. Select your comparison operator.
4. Enter the value you are looking for.
5. Click QUERY.

In this first example, let’s say we have a custom date field that we set up for *Baptism Date*. We want to find all folks who were baptized this year.

1. Click on SEARCH icon.
2. Choose Baptism Date.
3. Choose “is greater than” as the comparison.
4. Enter “01/01/11” as the date value.
5. Click QUERY.

The results of our query. So we know that these people have a baptism date later than 1/1/11.
In this next example, let’s say we want to find folks that are Members, Regular Attenders or Occasional Attenders.

1. Click on SEARCH icon.
2. Click on the Association tab.
3. Click over the Associations Member, Regular Attender and Occasional Attender.
4. Click QUERY.

For more details on using the query editor, see the “Using the Query Editor” chapter.

---

Tag People

If you are a deacon responsible for a certain group of people, or a children’s minister responsible for the children, you may want to “tag” those people that you work with most often. By tagging people, you can go straight to the Tagged People menu item, under Home to see those folks.
To tag people, do the following:
1. Do a query or find by to get the people in the list.
2. Highlight all the people you’d like “tagged”.
3. Right mouse click.
4. Select “Tag”.

To view the “tagged” people, do the following:
1. Expand the Home menu.
2. Click on Tagged People.
3. Your tagged people are listed here.

To “un tag” a person, do the following:
1. Expand the Home menu.
2. Click on Tagged People.
3. Highlight the folks you no longer want in your list.
4. Right mouse click, and select “unTag”.

Highlight the people you wish to remove from your list, right mouse click and select “unTag”. 

Expand the Home menu, and click on Tagged People. Your “tagged” people are listed here.
RUNNING REPORTS

The majority of reports in Roll Call are run in the same manner. This chapter discusses the methodology for running reports and walks you through much of the terminology. Whether you want a list of people, an attendance report, a contribution report, a pledge report or a group report, you will process them in the same manner.

Report Selection Window

To begin, you’ll need to decide which report you’d like to run. There is a report option under each of the main menu options on the left sidebar. For example, if you want to run a contribution report, expand the Contributions menu and select Reports. The report selection window for contribution reports will be displayed. Choose the specific report on the left sidebar of the window.

Expand the menu for the area you wish to report on, then click Reports.

Select your report on the left hand side.

Enter date range and other criteria.

Click GENERATE to run the report.

Notice there is also a Reports menu on the top menu. Once you drop down the reports menu you can choose Everyone, Associations, Shepherd Area, Keyword, Search Database or Tagged People. Again, the Report Selection window will be displayed for the area you choose.

Depending on the type of report you selected, there will probably be 3 tabs in the Report Selection Window: Criteria, Columns and View People. There may also be tabs across the middle of the page: Who, What and When.
Criteria
Most reports will be anchored in the Criteria tab. The information on the criteria tab will change based on what report you are running. For example, if you were running a contribution report, the criteria tab would allow you to enter the date range of contributions you wanted to include in the report.

Enter date range for the report.

Who
If the report you are running is for certain people, attenders or donors there may be a “Who” tab on the Criteria section. The Who tab allows you to select who should be considered for the report. For example, you will be able to run the report for certain associations, groups, keywords, shepherd areas or by using the query editor. First select the type, association, group, etc. Then choose the specific values you are interested in.

Select who you want to run this for.

Choose the specific values by moving value from left to right column.

For example, if you wanted a list of your members who donated to a certain fund, you would select association as the type, then click over Member to the selected column.
What
The “What” tab is used to further refine your criteria. For example if you are running a contribution report, which funds should be included. If you are running an attendance report, which attendance should be included.

Columns
Once you’ve identified who will be considered for the report, click on the Columns tab to change what data is included in the report. Each report has a standard set of columns that will be displayed, but if you’d like to change that, use the columns tab.

All the columns that are available for the report will be listed in the left column. If there is an arrow in front of a word like People or Addresses, this means you can expand the list of fields under that table. There is also a section called Special Columns. Special Columns combine pieces of information into one field. For example if you want the Head & Spouse as a field, or Parents Names as a field, these can be found under Special Columns. For a full listing of tables, field names and descriptions please see Appendix A.

View Records
The View Records tab allows you to see which people or data will be included in the report based on the criteria you selected.

Run the Report
When you click GENERATE, the report results will be displayed in the Report Output window.
Click on the arrow to view fields under each section.
Double click or drag a field from left column to “selected” column.
Move the selected columns around to order them in the report.

Report Output Window
The report results are displayed in the main section of the Report Output Window. Use the scroll bars on the bottom and to the right of the report to scroll up and down; left and right.

On the right side of the Report Output Window are actions that can be performed for the report.
1. Click on PAGE SETUP to set your printer and paper size and orientation.
2. Click on PREVIEW to preview the output. Do not send the report to the printer from this preview window, it will only send the first page to the printer.
3. To change fonts, column sizes etc., click CUSTOMIZE. The report will be displayed in 4D View, Roll Call’s spreadsheet program. Make your modifications here.
4. Click on PRINT to send the report to the printer.
5. Click ZOOM IN to make the font in the report larger on your screen.
6. Click ZOOM OUT to make the report font smaller on your screen.
7. To save the report as a tab delimited file or html document, click SAVE. Enter the location and name of the file to be saved.
8. Click SAVE SET to save the list of people for use later within Roll Call.
9. Click CREATE LABELS to create address labels (3 across 10 down size) for this list of people.
10. Click WRITE LETTER (not available in RC Lite), to compose a mail merge letter to this list of people.
11. Click EMAIL (not available in RC Lite) to send an email to this list of people or
to email the report to another individual. If you choose Email people, it will send the email to everyone listed in your report. If you choose Email report, the email editor will be displayed. You will need to enter the email address of the person you are emailing. Enter any introductory text in the body, the report will be sent as an attachment. Click SEND.

12. Click GRAPH to view the report data in a graphical format. This option is generally available for summary by week, month or year type reports.

13. To enlarge the window, click on the lower right corner of the window and drag to the appropriate size.
REPORTING ON PEOPLE

There are quite a few standard reports that can be run to obtain people type information. You can run a list of people who have a birthday, anniversary or significant date in a specific month. Or maybe you want a list of people with their envelope number. Maybe you’d like a one page summary about a family, or a report to send each family to confirm their contact information. All these reports can be found in the Reports menu under the People menu.

Report Window

Each report is run in a similar manner. This section will discuss the methodology for running the People reports. To select a report, do the following:

1. Expand the People menu.
2. Expand the Reports menu.
3. Highlight the report you’d like to run.

Once you’ve selected the report, you’ll see three tabs across the right side of the window. The criteria let’s you select who should be included in the report. Do you want the report for certain associations, shepherd areas, keywords, assigned envelopes or other criteria?

Note the three tabs.

Click on criteria tab, then choose which people you’d like in the report.

Click on columns tab.

Drag field name from left column to “Selected” to include on the report.

Click GENERATE to run the report.
Once you’ve identified who will be in the list, click on the Columns tab to change what data is included in the report. Each report has a standard set of columns that will be displayed, but if you’d like to change that, use the columns tab.

The View Records tab allows you to see which people will be included in the report based on the criteria you selected.

When you click GENERATE, most reports will be displayed in the Report Output window. From the report output window you can print the report, zoom in and out, or change page set up. You can also create mailing labels to the people listed in the report.

---

**Envelope Number Report**

The Envelope Number report lists people (based on your criteria selection) with their name, address and current envelope number. To run the report, do the following.

1. Expand the People menu.
2. Expand the Reports menu.
3. Highlight Envelope #.
4. From the criteria tab, select the associations, keywords, or shepherd area, or assigned envelopes that you’d like to see in the list.
Highlight Envelope # report.

In this example, I’ve choose to run the report for Associations and I selected Member.

5. If you’d like to change which columns are displayed in the report, click on the columns tab. Drag the field you’d like to add to the right side “Selected” column.
6. To change the sort order of the report, drag the field you’d like to sort on.
7. Click GENERATE to run the report.
Family Report

The Family report lists all the family members in the top section of the report. Next it shows the individual contact and email information. Next the addresses are outlined. Finally the group involvements (not available in RC lite) for each family member are listed. To run the report, do the following.

1. Expand the People menu.
2. Expand the Reports menu.
4. From the criteria tab, select the associations, keywords, or shepherd area, that you’d like to see in the list.
5. There isn’t a columns tab for this report. The format for this report is fixed.
6. Click GENERATE to run the report.

Choose who you want the reports for. In this example I’m running the family report for all families in the Evans shepherd area.

Click GENERATE to run the report.

Here’s an example of the Family Report.

<table>
<thead>
<tr>
<th>Name</th>
<th>Position</th>
<th>MF</th>
<th>Association</th>
<th>Date of Birth</th>
<th>Married Status</th>
<th>Initial Date</th>
<th>Modified Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mr. Juan Garcia</td>
<td>Headed</td>
<td>M</td>
<td>Member</td>
<td>8/19/79</td>
<td>Married</td>
<td>3/29/11</td>
<td>4/16/11</td>
</tr>
<tr>
<td>Mrs. Maria Garcia</td>
<td>Wife</td>
<td>F</td>
<td>Member</td>
<td>05/20/71</td>
<td>Married</td>
<td>3/29/11</td>
<td>4/5/11</td>
</tr>
<tr>
<td>Miss Gail Garcia</td>
<td>Youth</td>
<td>F</td>
<td>Member</td>
<td>12/2/26</td>
<td>Single</td>
<td>3/29/11</td>
<td>4/6/11</td>
</tr>
<tr>
<td>Mr. Sebastian Garcia</td>
<td>Child</td>
<td>M</td>
<td>Member</td>
<td>8/20/98</td>
<td>Single</td>
<td>3/29/11</td>
<td>4/5/11</td>
</tr>
<tr>
<td>Miss Jennifer Garcia</td>
<td>Child</td>
<td>F</td>
<td>Member</td>
<td>12/12/98</td>
<td>Single</td>
<td>3/29/11</td>
<td>4/6/11</td>
</tr>
</tbody>
</table>

Family eMail: johnsonfamily@liteshield.com
Personal eMail
Mr. Juan Garcia: juan@liteshield.com
Mrs. Maria Garcia: maria@liteshield.com
Mr. Sebastian Garcia: seb@liteshield.com

Personal Phones

Local Address

<table>
<thead>
<tr>
<th>Address</th>
<th>Phones</th>
<th>Alternate Address</th>
<th>Effective Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>2190 Neil, Byrne, IL 61510</td>
<td>(812) 029-0912</td>
<td></td>
<td>00:00 to 09:00</td>
</tr>
</tbody>
</table>

Shepherd Area: Johnson

Wedding Date: 00:00:00

Comment on Address

Take left at light

Group involvements

Mr. Juan Garcia: davetest
Miss Jennifer Garcia: a
Birthday Report

The Birthday report will list all the people that meet your birthday criteria and that are in the associations, shepherd areas, groups or keywords. The default birthday report lists the name, address, birthday and age. To run the report, do the following:

1. Expand the People menu.
2. Expand the Reports menu.
4. From the criteria tab, chose your birthday date range.
5. From the criteria tab, select the associations, keywords, or shepherd area that you’d like to consider for the report.

6. If you’d like to change which columns are displayed in the report, click on the columns tab. Drag the field you’d like to add to the right side “Selected” column.
7. To change the sort order of the report, drag the field you’d like to sort on.
8. Click GENERATE to run the report.
Anniversary Report

The Anniversary report will list all married folks who have an anniversary in your date range and that are in the associations, shepherd areas, or keywords selected. The default anniversary report lists the name, address, anniversary and length married. To run the report, do the following:

1. Expand the People menu.
2. Expand the Reports menu.
4. From the criteria tab, choose your date range.
5. From the criteria tab, select the associations, keywords, or shepherd area that you’d like to consider for the report.

Also select the folks you want to consider for this report. In this example I will look for any member, regular attender or occasional attender who has an anniversary in January.
6. If you’d like to change which columns are displayed in the report, click on the columns tab. Drag the field you’d like to add to the right side “Selected” column.

7. To change the sort order of the report, drag the field you’d like to sort on.

8. Click GENERATE to run the report.

---

**Significant Dates**

The Significant Dates report will list all folks who have a significant date in your date range and that are in the associations, shepherd areas, or keywords selected. The default report lists the name, address, the significant event and date. To run the report, do the following:

1. Expand the People menu.
2. Expand the Reports menu.
4. From the criteria tab, chose your date range.
5. From the criteria tab, select the associations, keywords, or shepherd area that you’d like to consider for the report.
Highlight Significant Date report on left side menu.

From the criteria tab, choose time frame, and who you want to consider for the report.

6. If you’d like to change which columns are displayed in the report, click on the columns tab. Drag the field you’d like to add to the right side “Selected” column.
7. To change the sort order of the report, drag the field you’d like to sort on.
8. Click GENERATE to run the report.

Click on the columns tab.

To add fields to the report, drag the field name to the “Selected” column.

Click GENERATE to run the report.

Use the top buttons to print, zoom or change page setup.
Confirm Data Report

The Confirm Data summarizes the family's contact information. This report is set up as a letter to the family so that they can confirm their contact information. To run the report, do the following.

1. Expand the People menu.
2. Expand the Reports menu.
3. Highlight Confirm Data Report.
4. From the criteria tab, select the associations, keywords, or shepherd area, that you’d like to see in the list.
5. There isn’t a columns tab for this report. The format for this report is fixed.
6. Click GENERATE to run the report.

Select the criteria for who you want to have a confirmation report printed.

Click GENERATE to run the report.

An example of the confirm data report. Note when folded, this fits in #9 envelope.
Uninvolved Families Report

The Uninvolved Families report allows you to find families that:

1. Have not given since a certain date
2. Have not attended any service or group since a certain date (not available in RC lite)
3. Are not members of an active group (not available in RC lite)

To run the report, do the following.
1. Expand the People menu.
2. Expand the Reports menu.
4. From the criteria tab, chose the uninvolved criteria.

5. From the criteria tab, select the associations, keywords, or shepherd area that you’d like to consider for the report.
6. If you’d like to change which columns are displayed in the report, click on the columns tab. Drag the field you’d like to add to the right side “Selected” column.
7. To change the sort order of the report, drag the field you’d like to sort on.
8. Click GENERATE to run the report.
My Reports

The My Reports area allows each user to build their own reports. These reports can then be saved to run again in the future. To create a report, do the following:

1. Expand the People menu.
2. Expand the Reports menu.
3. Highlight My Reports.
4. From the criteria tab, select the associations, keywords, or shepherd area that you’d like to consider for the report.
5. Click on the columns tab and drag the columns you’d like in the report to the right side “Selected” column.
6. To change the sort order of the report, drag the field you’d like to sort on to the Sort Column.
7. To save the report, click SAVE and name the report.
8. Click GENERATE to run the report.

To select a column for the report, drag from left column to “Selected” column.

Click GENERATE to run the report. Click RESET to reset back to default values.
Select the criteria for which people you’d like in this report.

Highlight My Reports.

To select a column for the report, drag from left side to “Selected” column.

Click GENERATE to run the report.

Click SAVE to save this report for later use.

Use this drop down to retrieve saved reports.
ENTERING CONTRIBUTIONS

Giving Funds

Before you can begin entering contributions in Roll Call, the giving funds must be defined. The giving funds are the designations that people can contribute to. A new Roll Call database will contain one giving fund, “General”. To add giving funds, do the following:

1. Expand the Contributions menu on the left side bar.
2. Click on Giving Funds
3. Click on the plus sign in the lower left of the Giving Fund summary window.

4. Enter the Fund name. This is the name that will be in the drop down box to select designations from the Enter Contributions screen.
5. Enter the associated Account Number. This number is not mandatory.
6. If this giving fund is no longer valid or used, check the “Inactive” box.
7. If this fund is not tax deductible, mark the box for “Not on Receipt”. If this box is checked any monies given to this fund will not be printed on the year-end tax statement.

Enter the fund name and account number.
Enter GL Account mapping information.
Click on Giving Funds, under the Contributions menu.
Click on the plus sign to add a new fund.
Click SAVE to save the information.
8. Select the Fund Color. This color will represent the fund in pie charts showing total giving. Click on the “…” and click on the color you’d like to use.

9. The GL Fund is used to map the giving funds to your accounting system. For example if you have a giving fund of “Tithes & Offerings” and you want that to map to the General Income Fund in your accounting system, you would enter General Income as the GL Fund. If you are importing into Quickbooks and your fund is a sub-account, enter the Account, then a colon then the sub account name, for example, Operating Income:General.

10. The GL Account Number is the account number to map to MYOB accounting.

11. GL Key is the number to map to Roll Call’s accounting system.

Batches

All contributions are entered in Roll Call through a batch. A batch is nothing more than a grouping of contributions. Typically, users will enter all the giving for a deposit in a batch.

Because of the integration with Accounting, batches must be either Cash or Non-Cash. Cash contributions include all cash, checks, credit cards and ACH type transactions. Non-Cash batches contain property gifts, things that cannot be deposited into the bank.

To create a batch, do the following:
1. Expand the Contributions menu on the left side bar.
2. Click on Add Batch.

Enter the following information:
1. **Batch Date** – This date will become the default for all contributions entered in this batch.
2. **Description** – Enter a qualifying description of this batch. Especially if you will have multiple batches for the same day. Maybe this group of contributions is for the 9 a.m. service. You could enter “9 a.m. service” as the description.
3. **Anonymous Cash** – Enter the amount of loose cash that was in the offering. This is cash that cannot be associated with any specific donor.

Click on Add a Batch.

Enter amount of loose cash in offering.

Select Batch Type.

Enter control totals.

Click plus sign to enter individual contributions.
4. **Cash Fund** – Enter the fund that the anonymous cash should be designated to.

5. **Default Fund** – Enter the fund that you’d like all contributions in this batch to default to. This doesn’t mean that you can’t have other funds included in this batch. This is only used as a default. If the majority of the giving is for Tithes & Offerings… make “Tithes & Offerings” the default fund.

6. **Batch Type** – Select Cash for batches that will contain cash, checks, credit card, online, ACH type contributions. Select Non-Cash for property or in-kind gifts.

7. **Asset Fund** – This is the fund to map non-cash gifts to the appropriate asset fund in your accounting system.

8. **Batch Control Count** – This field can be used as a control count for the number of entries expected in this batch. This field is not required, but by using it you may be able to catch any data entry errors. If the Batch Count and Batch Control Count do not match, they will be displayed in red.

9. **Batch Control Total** – This field can be used as a control total for the amount expected in this batch. This field is not required, but by using it you may be able to catch any data entry errors. If the Batch Total and Batch Control Total do not match, they will be displayed in red.

10. To begin entering individual contributions, click on the plus sign in the lower left corner.

### Check/Cash Contributions

To begin entering cash or cash equivalent contributions, you will need to create a batch. To create a new batch, do the following:

1. Expand the Contributions menu.
2. Click on Add Batch.
3. Enter the batch header information as described in the previous section.
4. Click on the plus sign in lower left to begin entering the contributions.

To enter new contributions to an existing batch, you will need to locate your batch.

1. Expand the Contributions menu.
2. Click on Search by Batch.
3. Change the Find By Criteria to “Date”.
4. Select the date of the batch you are adding to.
5. Double click on the appropriate record.
6. Click on the plus sign in the lower left to begin entering new contributions.

### Basic

To record a donation, enter the following information:

1. **Donor Name or Envelope Number**. When recording contributions, the first thing you need to do is identify the donor. If you use envelope numbers, enter the number and press tab. The donor information will be displayed on the right side. If you use name to identify the donor, enter the last name then press tab. You will be taken to the Select a Person window. You can further reduce the names in the list by typing the first few characters of the first name. You can double click on the name to select it, or if it is already highlighted, press Enter on your keyboard.

2. **Date** – the donation date will default to the same as the batch date. If you’d like to change this date you can enter it here.

3. **Total Amount** – Enter the amount of the contribution.

4. **Check Number** - If the contribution was a check, you may enter the check number in this field.

5. **Donation Type** – If you entered a check number, this will automatically change to check. Or you can select cash, check, credit card etc. from the drop down list of values.
6. **Designation** – Use the drop down list of values to select the fund that these monies were given to.

Click SAVE & NEW to enter a new contribution in this batch. Click SAVE & CLOSE to save the current contribution and return to Batch window.
Split

A split donation is a single contribution that needs to be designated to 2 or more funds. To record a split donation, enter the following information:

1. **Donor Name or Envelope Number.** When recording contributions, the first thing you need to do is identify the donor. If you use envelope numbers, enter the number and press tab. The donor information will be displayed on the right side. If you use name to identify the donor, enter the last name then press tab. You will be taken to the Select a Person window. You can further reduce the names in the list by typing the first few characters of the first name. You can double click on the name to select it, or if it is already highlighted, press Enter on your keyboard.

2. **Date** – the donation date will default to the same as the batch date. If you’d like to change this date you can enter it here.

3. **Total Amount** – Enter the amount of the contribution.

4. **Check Number** - If the contribution was a check, you may enter the check number in this field.

5. **Donation Type** – If you entered a check number, this will automatically change to check. Or you can select cash, check, credit card etc. from the drop down list of values.

6. **Amount** – Notice the amount and designation fields underneath the contribution header information. Place your cursor in the amount field, and reduce the amount so that it matches the amount to be designated to the first fund. Press TAB. Note a 2nd line is created with the remainder, so you can designate that amount.

7. **Designation** – Use the drop down list of values to select the fund that these monies were given to.

---

**Quid Pro Quo**

Quid Pro Quo contributions are contributions where something of value was given. For example, if your youth group is selling CD’s as a fund raiser. The CD’s are worth $15. If someone gives the youth group $50 for the CD, you’d want to enter that as a Quid Pro Quo contribution.

To enter this transaction, go to the Donation Entry window and enter the following information:

1. **Donor Name or Envelope Number.** When recording contributions, the first thing you need to do is identify the donor. If you use envelope numbers, enter the number and...
press tab. The donor information will be displayed on the right side. If you use name to identify the donor, enter the last name then press tab. You will be taken to the Select a Person window. You can further reduce the names in the list by typing the first few characters of the first name. You can double click on the name to select it, or if it is already highlighted, press Enter on your keyboard.

2. **Date** – the donation date will default to the same as the batch date. If you’d like to change this date you can enter it here.

3. **Total Amount** – Enter the amount of contribution. In the above example this would be the $50.00.

4. **Check Number** - If the contribution was a check, you may enter the check number in this field.

5. **Donation Type** – If you entered a check number, this will automatically change to check. Or you can select cash, check, credit card etc. from the drop down list of values.

6. **Designation** – Use the drop down list of values to select the fund that these monies were given to.

7. Click on the Quid Pro Quo tab. Select the item that was given. Enter the value of the item given. In this example the item was the CD. The value was $15.

Click SAVE & NEW to enter a new contribution in this batch. Click SAVE & CLOSE to save the current contribution and return to the Batch window.
Non-Cash/Property Gift Contributions

There are 3 ways that you can enter an in-kind or property gift in Roll Call.

1. **Donation Type** – Use the donation type method if you’d like to assign a value to the property gift. You will need to use this method if you want to apply this gift towards a pledge.
2. **In-Kind tab** – Use this method if you do not want to assign a value to this gift.
3. **Non-Cash screen** – Use this method if you have a complicated transaction such as stock or real estate where brokerage fees need to be applied.

### Donation Type

To record a property gift using the Donation Type method do the following:

1. Create a non-cash type batch.
2. Click on the plus sign in the lower left.
3. Enter **Donor Name or Envelope Number**. When recording contributions, the first thing you need to do is identify the donor. If you use envelope numbers, enter the number and press tab. The donor information will be displayed on the right side. If you use name to identify the donor, enter the last name then press tab. You will be taken to the Select a Person window. You can further reduce the names in the list by typing the first few characters of the first name. You can double click on the name to select it, or if it is already highlighted, press Enter on your keyboard.
4. **Date** – the donation date will default to the same as the batch date. If you’d like to change this date you can enter it here.
5. **Total Amount** – Enter approximate value of the gift. This amount will be listed on the year end tax statement with an asterisk to indicate that this amount needs to be determined by the donor.
6. **Donation Type** – Select a donation type that has been defined as a “non-cash” type.
7. **Designation** – Use the drop down list of values to select the fund that these monies were given to.
8. **Description** – Enter a description of the property donated.

Click SAVE & NEW to enter a new contribution in this batch. Click SAVE & CLOSE to save the current contribution and return to Batch window.

### In Kind tab

To enter a property gift without having to enter an amount, do the following:

To record a property gift using the Donation Type method do the following:

1. Create a non-cash type batch.
2. Click on the plus sign in the lower left.

Enter value of in-kind gift. Enter Donation Type that is classified as “non-cash”.

Enter description of gift.
3. Enter *Donor Name or Envelope Number*. When recording contributions, the first thing you need to do is identify the donor. If you use envelope numbers, enter the number and press tab. The donor information will be displayed on the right side. If you use name to identify the donor, enter the last name then press tab. You will be taken to the Select a Person window. You can further reduce the names in the list by typing the first few characters of the first name. You can double-click on the name to select it, or if it is already highlighted, press Enter on your keyboard.

4. *Date* – the donation date will default to the same as the batch date. If you’d like to change this date you can enter it here.

5. *Total Amount* – Leave this amount 0.

6. *Donation Type* – Select a donation type that has been defined as a “non-cash” type.

7. Click on the In Kind tab. You may enter the *amount and designation* if you wish. This will be for informational purposes only. The amount will not be used on year-end statements or against pledges.

8. *Description* – enter the description of the property gift. This description will be listed on the donation receipt.

Click SAVE & NEW to enter a new contribution in this batch. Click SAVE & CLOSE to save the current contribution and return to Batch window.
Check Reader

The check reader, approved to work with Roll Call, is the Mag-Tek keyboard wedge device check reader. You may order this from us at 800.554.9116 and we’ll configure it for you.

To begin recording donation, get to the Enter Donation screen.
1. Slide the check through the check reader, with the magnetic numbers on the bottom facing inward.
2. If Roll Call recognizes the account number, the name of the donor and the check number will be displayed. All you need to enter is the Amount and the Designation. Press SAVE & NEW to enter another donation.
3. If Roll Call does not recognize the account number, it will ask you to identify the donor. Enter the Last Name or portion of the last name. A list of all people with that last name will be displayed. Double click to select the appropriate person.
4. Now the account number from the check and the person are linked. The next time you get a check from them, Roll Call will automatically pull up their information.

Import Contributions

If you use a service for online contributions, you can import those contributions into Roll Call. We can import a csv file with the following information in this exact order:
1. Date
2. Last Name
3. First Name
4. Address 1
5. CityNav
6. State
7. Postal Code
8. Amount
9. Fund

The import will create a batch with a contribution for each line in the import file. Each contribution will be assigned a donation type of Credit Card. To find the appropriate donor, we will look for a match on name and address. If no match is found, it will create a person record with the association of IMPORT. If the fund is not found in Roll Call, a giving fund will be created.

To import the contributions, do the following:
1. Expand the Contributions menu on the left side bar.
2. Click on Import.
3. Click on the Import button.
4. Navigate to your csv file that you wish to import, highlight it and click OPEN.
5. You will get a message that the import is complete.
6. The batch window will be displayed for you to review the import.

Post a Batch

Posting a batch in Roll Call sets several things in motion. When you post a batch:
1. The batch can NO LONGER be modified.
2. If you are using Roll Call Accounting the receipt information will be sent to the
accounting system.

3. If you are using Quickbooks or MYOB, you can create your export files as part of the posting process.
4. As part of the post process you can choose to print the batch summary and batch detail report.
5. As part of the post process you can choose to print a deposit slip.

To post a batch do the following:
1. Expand the Contributions menu.
2. Click on Search by Batch.
3. Highlight one or more batches that need to be posted.
4. Click on POST BATCH button in the lower right of the window.
5. You will be presented with a list of reports to run. Check the options you’d like to print.

**Import deposit to QB or MYOB**

When you post a batch in Roll Call you will be given the option to export for MYOB or Quickbooks. If you marked either box to create an export file, you will be prompted for a folder to create the file in. The file will automatically be named. Next you will be prompted for the bank account name that you’ll be depositing the money into.

To import the file in Quickbooks, do the following:
1. Open Quickbooks.
2. Select File>Utilities>Import>IIF files.
3. Navigate to the file you just created.
4. You should now have a deposit journal entry representing the batch.

To import the file into MYOB, select File>Import. Navigate to the file you just created. You now have a deposit journal entry that represents this batch.

**Batch Reports**

There are two batch reports available when you post a batch. The first is the batch summary report. This report will outline how much was given to each fund in this specific batch. The second report is the batch detail report. It will outline each donor and how much was given.
To run these reports, mark the box for Batch Summary and or Batch Detail after you choose to Post the batch.

From the batch window, click on POST to post the batch.

From the Search by Batch window, highlight one or more batches and click POST.
Mark the reports you’d like to run and the export files you’d like to create.

Click POST to run the reports and post the batch.

The Batch Summary shows how much was given to each fund in this batch.
The Batch Detail lists all donations included in a batch.

Deposit Slip

When you close a batch there is an option to print a deposit slip for the batch. Check the box to print the deposit slip. Click OK.

Mark the box to print a deposit slip for the current batch.

If you’d like a deposit slip to include multiple batches, highlight those batches, choose to close, then mark combined.

Lists contributions.

Totals by cash and check.
LOOKING UP CONTRIBUTIONS

Search by Person
To research the contribution data for a specific individual, you can use the Search by Person option under the Contributions menu.

Find By
To use the Find By option, do the following:
1. Expand the Contributions menu.
2. Click on Search by Person.
3. Select your Find By criteria. You can select last name, association, or envelope number.

4. Enter your criteria.
5. The people that meet that criteria will be displayed.
6. Double click to view details.
Query Editor

If you need to find a person by criteria other than last name, envelope number, or association, you’ll need to use the query editor. To use this option, do the following:
1. Expand the Contributions menu.
2. Click on the Search by Person menu option.
3. Click on the SEARCH icon.
4. Select the field you’d like to query on.
5. Highlight the comparison operator.
6. Enter the value that you are looking for.
7. Double click on the appropriate person to view their contributions.

Choose the Search by Person menu under Contributions. Then click on SEARCH icon.

Choose table to query in. This drives what fields will be in the list.

Choose comparison and the value you are looking for.

Click QUERY to return people that meet this criteria.

Results

Once you have double clicked on a person’s record, you will get a window that displays all their individual gifts on the left hand side of the screen. To look at the individual contribution record, double click to see the contribution entry.

The right side of the window displays summary information. Use the drop down to select your view. You can choose to view a summary by Year or Overall. The Yearly Summary will show a bar graph by year. The Overall Summary will display the individual’s giving in a pie chart by fund. The Details by Month will show a line graph of giving totals by month. The Details by Week will show a line graph of giving by week.
Each contribution is listed on the left.

Choose the type of summary information you’d like to see.

The Summary Overall shows giving over all time by fund.

The Details by Month shows a line graph of giving by month.

The Details by Week shows a graph of giving for the last 12 weeks.
Search by Batch

To research the contribution data for a specific batch, you can use the Search by Batch option under the Contributions menu.

Find By

To use the Find By option, do the following:
1. Expand the Contributions menu.
2. Click on Search by Batch.
3. Select your Find By criteria. You find batches based on date, fund, description or year.
4. Enter your criteria.
5. The batches that meet the criteria will be displayed.
6. Double click to view details.

Query Editor

If you need to find a batch by criteria other than the fields listed in the Find By drop down, you’ll need to use the query editor. To use this option, do the following:
1. Expand the Contributions menu.
2. Click on the Search by Person menu option.
3. Click on the SEARCH icon.
4. Select the field you’d like to query on.
Click on Search by Batch, then click on the SEARCH icon.

Choose table to query in. This drives what fields will be in the list.

Choose comparison and the value you are looking for.

Click QUERY to return people that meet this criteria.

5. Highlight the comparison operator.
6. Enter the value that you are looking for.
7. Double click on the appropriate batch to view the details.

**Results**

Once you have double clicked on batch, the batch window will be displayed. To view the details for a specific contribution, double click on it.

**In People Profile**

If you are working the People screen, you can view the contributions for that individual. To view contributions within an individual’s record, do the following:

1. Expand the People menu.
2. Click on Search Profiles.
3. Use the Find By to select your criteria to find the person.
4. Double click on the record of the person you are interested in.
5. Click on the Contributions tab.
6. Use the display option to select how you’d like the contributions displayed. The choices are Summary by Year, Overall Summary, Detail by Month and Detail by Week.
Summary by Year charts the giving for each year.

Summary totals for each year are displayed.

The Summary Overall charts all giving and charts it by Fund.

Totals by fund are listed on the right side.

Details by Month charts giving by the last 12 months.

Detailed contributions are listed on the right side. Double click to view contribution record.
Details by Week, charts the last 12 weeks giving.

All contributions are listed on the right. Double click to view contribution record.
MODIFYING CONTRIBUTIONS

Open Batches
If a batch has not been posted, you can add contributions to that batch and you can make corrections to individual contributions in that batch.

Add Contributions to Existing Batch
To add contributions to an existing batch, find the batch by selecting Search by Batch under the Contributions menu. Double click on the batch you need to modify. From the batch window, click on the plus sign in the lower left to start adding new contributions.

Correct a Contribution
To correct a contribution that has already been recorded in Roll Call, you will need to find that specific contribution. If you know the batch it was in, click on Search by Batch under the Contributions menu. Double click on the batch. Double click on the specific contribution.

If you know the person that made the contribution, select Search by Person under the Contributions menu. Double click on the appropriate person. Find the contributions on the left side, double click on it. Make the necessary changes.
You can change the date, amount, type and check number.

You can modify the designation by using the drop down box.

To change the total amount, date, or type, place your cursor in the field and make the correction. To change the fund it was designated to, use the drop down to the right of designation and choose the correct fund.

To change the donor, click on the TRANSFER button and enter the last name for the correct donor. Select the appropriate person from the list.

Click SAVE & CLOSE to save the changes to the contributions record and return to the Search screen.

**Posted Batches**

Corrections are not allowed to posted batches. If errors were made in the batch, you will need to reverse the batch, make the correction, then re-post the batch.

**Reverse the Batch**

When you reverse a batch, a reversing journal entry will be written in the Roll Call Accounting system. Then the status of the batch will change to un-posted. At this point you can make corrections to the batch.

To reverse the batch, do the following:
1. Expand the Contributions menu.
2. Click on Search by Batch.
3. Highlight the batch that needs to be reversed.
4. Click the REVERSE button.

Highlight the batch you need to reverse.

Click REVERSE.
You may also reverse from the batch window:
1. Expand the Contributions menu.
2. Click on Search by Batch.
3. Double click the batch that needs to be reversed.
4. Click the REVERSE button.

Correct the Contribution
Now that the batch is “un-posted”, you can make corrections to existing contributions or add contributions to the batch. To correct a contribution that has already been recorded in Roll Call, you will need to find that specific contribution. Click on Search by Batch under the Contributions menu. Double click on the batch. Double click on the specific contribution.

To change the total amount, date, or type, place your cursor in the field and make the correction. To change the fund it was designated to, use the drop down to the right of designation and choose the correct fund.

To change the donor, click on the TRANSFER button and enter the last name for the correct donor. Select the appropriate person from the list.

Click SAVE & CLOSE to save the changes to the contributions record and return to the Search screen.

Re-post the Batch
Once you have corrected the batch, you will need to post it, to send the information over to Roll Call Accounting. To post the batch:
1. Expand the Contributions menu.
2. Click on Search by Batch.
3. Highlight one or more batches that need to be posted.
4. Click on POST BATCH button in the lower right of the window.
5. You will be presented with a list of reports to run, check the options you’d like to print.

Transfer Contributions
If a contribution was assigned to the wrong donor, you can transfer the contribution to the correct donor at any time. You can do this for posted and un-posted batches.
A single contributions
To transfer a contribution that has already been recorded in Roll Call, you will need to find that specific contribution. If you know the batch it was in, click on Search by Batch under the Contributions menu. Double click on the batch. Double click on the specific contribution.

If you know the person that the contribution is under, select Search by Person under the Contributions menu. Double click on the appropriate person. Find the contributions on the left side, double click on it.

To change the donor, click on the TRANSFER button and enter the last name for the correct donor. Select the appropriate person from the list.

Multiple contributions
A good example of having to transfer multiple contributions from one person to another, would be from a wife to the husband. Another example might be person with the same name. To transfer multiple donations at once, do the following:
1. Expand the People menu on the left.
2. Click on Search Profiles.
3. Find the person who currently has the contributions.
4. Double click on their record.
5. Click on the Contributions tab.
6. Change the view to Detail by Month or Detail by Week.
7. Highlight one or more contributions that need to be transferred.
8. Right mouse click and select Transfer
9. Enter the last name of the correct donor.
10. Select the appropriate person.

Open the record for the person you are transferring donations from. Click on Contributions tab.

Change view to Detail by week or month.

Highlight contributions to be transferred. Right mouse click and select transfer.

Enter the last name or portion of the last name.

Select the appropriate person.

Delete Contributions

Contributions can be deleted from an un-posted batch. The contribution can be deleted from the batch window or from the individual contribution screen.

To delete one or more contributions from the batch window, do the following:
1. Expand the Contributions menu.
2. Click on Search by Batch.
3. Use the Find By to select your criteria to find the batch.
4. Double click on the batch you need to delete from.
5. Highlight one or more contributions.
6. Click on the minus sign.

To delete a contribution from the contribution window, do the following:
1. Expand the Contributions menu.
2. Click on Search by Batch.
3. Double click on the batch you need to delete from.
4. Double click on the specific contribution you need to delete.
5. Click on the DELETE button.
Highlight the contributions you need to delete.

Click on minus sign.

From the individual donation record, click DELETE.
CREATING CONTRIBUTION RECEIPTS
(STATEMENTS)

Contribution Receipt Process
The flow for creating contribution statements is as follows:
1. Expand the Contributions menu.
2. Click on the Bulk Receipts menu item. The Contribution Receipts window will be displayed.
3. Choose your receipt type on the criteria tab.
4. Mark the applicable items on the criteria tab.
5. Click on the View People tab to see all the folks that will be receiving a statement.
6. Click on the Receipt Text tab. Customize your text areas.
7. Click PRINT RECEIPTS to print the statements.

Contribution Statement Formats
To begin the process of creating the donation receipts, you’ll need to choose the type of contribution statement.

Quarterly
The quarterly statement is for a single quarter. It will list either summary information or detail all the contributions made in that quarter.

Quarterly receipt for period 1/1/11 - 3/31/11.

Details were chosen to be listed.

Footnote text for non-cash gift item.
Quarterly Tabular

The quarterly tabular receipt shows weekly giving for the quarter.

Weekly giving amounts listed under each month.

Annual

The annual statement summarizes all giving for the year. The statement can show totals by fund or just a grand total. You can also list all contributions for the year as well.

Annual statement for 2011. Includes all details.
Canadian
The Canadian receipts show total giving for the year. The information required by the government in Canada is included on this receipt.

Individual Gift
This receipt is for a single contribution.
Quarterly Statements

To create quarterly receipts, do the following:
1. Expand the Contributions menu.
2. Click on the Bulk Receipts menu item. The Contribution Receipts window will be displayed.
3. Choose Quarterly Receipt from the Receipt Type drop down.

Criteria

When you choose Bulk Receipts, the Contribution Receipt window will be displayed. You will be anchored on the Criteria tab. From this tab, you can choose the type of receipt you want and what information should be displayed on the report.

Enter the following information:
1. Year - Indicate the year that these receipts are for.
2. Quarter – Indicate which quarter you are interested in.
3. Period Starting - This date is defaulted to the beginning of the quarter or year you selected. These dates may be changed.
4. Period Ending - This date is defaulted to the end of the quarter or year you selected. This date may be changed.
5. Total Giving for Period Over – If you only want to produce statements for folks who gave over a certain amount, enter that amount here.
6. Receipt Details – choose if you’d like the receipt to only have a grand total or if you’d like it to display summary information by fund. You may also choose to display each individual gift.
7. Include Summary by Fund – If you selected Summary & Details under Receipt Details, you can mark this box if you’d like to display the summary information by fund.
8. Include Detailed Gifts – If you selected Summary & Details under Receipt Details, you can mark this box if you want to list each contribution for the period.
9. Single Print Job – under the print options section, mark this box if you want Roll Call to create 1 large print job for the quarterly receipts. If you will be duplexing the print job (printing on both sides of the paper) you do not want to create a single print job. If you are emailing receipts you do not want to create a single print job. If you are using a large copier printer that requires a project code, you would want to check this box.
10. **Cover Letter** – if you’d like to print a cover letter before each statement, mark this box. Use the text tab to create your cover letter.

11. **Print on Stationary** - mark this box if you will be printing the statements on letterhead. By checking this box, the churches return address will not be printed on the statement. The statement will begin about 2 ½ inches down the page.

12. **Report In Kind giving** – if you entered property or in-kind gifts without an associated amount and you want to display the item descriptions in the lower section of the receipt, mark this box.

13. **Show Envelope Number** – if you would like the envelope number printed on the statement, mark this box.

14. **Sorted By** – choose the sort order of the print job. Do you want the receipts sorted by zip code or by name?

15. **Exclude** – to exclude receipts for folks who have an address marked as “bad” or “do not send”, mark this box.

**Text**

There are seven different types of “text” that can be used to customize your receipt. They are as follows:

1. **Top Text** – The top text area is used as a thank you note at the beginning of the statement. If you have a verse or a paragraph that you’d like printed at the beginning of the statement, use the top text area. If you have large thank you note, we recommend you use the cover letter section.

2. **Cover Letter** – The cover letter is a 1 page letter that will be printed before each statement.

3. **Bottom Text** – The bottom text area is used as footer text. It typically indicates no goods or services were received.

4. **NonCashGifts** – if the donor had any non-cash gifts where an amount was assigned to the gift, an asterisk will be placed beside the amount. Then at the bottom of the statement, there will be an asterisk with the verbiage you enter for non-cash gifts. Usually this would state that the donor is responsible for determining the fair market value of the gift.

5. **Third Party Gift** – if a donor gave a foundation monies to donate to your ministry on their behalf, the foundation is responsible for giving them a receipt. However, you would want to include the gift with a notation that the “third party” is responsible for receipting them.

6. **QPQ Gifts** – if the donor received something of value for their contribution, maybe a CD or T-shirt, the QPQ value is indicated on the receipt. Use the QPQ Gift text to
indicate that the amount of the item is reduced from their total contribution.

7. In Kind Gift – if you have a property donation where no value was assigned, these gifts are listed underneath the detail section of the statement. This text will be used as the header for the In Kind Gifts.

To enter the text you’d like displayed on the statement, do the following:
1. Click on the Receipt Text tab.
2. Click on the type of text you’d like to enter.
3. Enter the text and format it as appropriate.
4. The next window asks you to select the receipt format. First, second, third and forth quarter receipts display a summary of donations given within that quarter plus the donation detail.

To include the church name and address and/or donors name and address on the cover letter text, place your cursor in the position that you want a field, for example, “addressed to”. Then choose that information from the Function drop down box on the lower section of the word processor.

View People

The view people tab is used to review the list of people that will be getting a statement. If you’d like to print a receipt for all these people, click PRINT RECEIPT. If you only want to print them for several of the people in the list, highlight the people that you want, then click PRINT RECEIPTS. It will only print statements for those people that were highlighted.
Click on the Receipt text tab.

Click on the type of text you’d like to customize.

Printing your receipt
Once you have set up your criteria, reviewed the list of people and set up your text areas, click on PRINT RECEIPTS. The statements will be printed for everyone in the view people tab. If you want to print a receipt for everyone in the list simply highlight all the people, then click PRINT RECEIPT.

Quarterly Tabular Statements
To create quarterly tabular receipts, do the following:
1. Expand the Contributions menu.
2. Click on the Bulk Receipts menu item. The Contribution Receipts window will be displayed.
3. Choose Quarterly (tabular) Receipt from the Receipt Type drop down.

Criteria
When you choose Bulk Receipts, the Contribution Receipt window will be displayed. You will be anchored on the Criteria tab.

Enter the following information:
1. **Year** - Indicate the year that these receipts are for.
2. **Quarter** – Indicate which quarter you are interested in.
3. **Special Gifts** – Indicate which funds should be listed on the right side as “special
Annual Statements
To create quarterly receipts, do the following:
1. Expand the Contributions menu.
2. Click on the Bulk Receipts menu item. The Contribution Receipts window will be displayed.
3. Choose Annual Receipt from the Receipt Type drop down.

Criteria
From this tab, you can choose the type of receipt you want and what information should be displayed on the report.

Enter the following information:
1. Year - Indicate the year that these receipts are for.
2. **Period Starting** - This date is defaulted to the beginning of the year you selected. These dates may be changed.

3. **Period Ending** - This date is defaulted to the end of year you selected. This date may be changed.

4. **Total Giving for Period Over** - If you only want to produce statements for folks who gave over a certain amount, enter that amount here.

5. **Receipt Details** – choose if you’d like the receipt display only a grand total or if you’d like it to display totals by fund. You may also choose to list each individual gift.

6. **Include Summary by Fund** – If you selected Summary & Details under Receipt Details, you can mark this box if you’d like to display the summary information by fund.

7. **Include Detailed Gifts** – If you selected Summary & Details under Receipt Details, you can mark this box if you want to list each contribution for the period.

8. **Single Print Job** – under the print options section, mark this box if you want Roll Call to create 1 large print job that includes all the receipts. If you will be duplexing the print job (printing on both sides of the paper) you do not want to create a single print job. If you are using a large copier printer that requires a project code, you would want to check this box.

9. **Cover Letter** – if you’d like to print a cover letter before each statement, mark this box. Use the text tab to create your cover letter.

10. **Print on Stationary** - mark this box if you will be printing the statements on letterhead. By checking this box, the churches return address will not be printed on the statement. The statement will begin about 2 inches down the page.

11. **Report In Kind giving** – if you entered property or in-kind gifts without an associated amount and you want to display the item descriptions in the lower section of the receipt, mark this box.

12. **Show Envelope Number** – if you would like the envelope number printed on the statement, mark this box.

13. **Sorted By** – choose the sort order of the print job. Do you want the receipts sorted by zip code or by name?

14. **Exclude** – to exclude receipts for folks who have an address marked as “bad” or “do not send” mark this box.

---

**Text**

There are seven different types of “text” that can be used to customize your receipt. They are as follows:

1. **Top Text** – The top text area is used as a thank you note at the beginning of the statement. If you have a verse or a paragraph that you’d like printed at the beginning.
of the statement, use the top text area. If you have large thank you note, we recommend you use the cover letter section.

2. Cover Letter – The cover letter is a 1 page letter that will be printed before each statement.

3. Bottom Text – The bottom text area is used as footer text. It typically indicates no goods or services were received.

4. NonCashGifts – if the donor had any non-cash gifts where an amount was assigned to the gift, an asterisk will be placed beside the amount. Then at the bottom of the statement, there will be an asterisk with the verbiage you enter for non-cash gifts. Usually this would state that the donor is responsible for determining the fair market value of the gift.

5. Third Party Gift – if a donor gave a foundation monies to donate to your ministry on their behalf, the foundation is responsible for giving them a receipt. However, you would want to include the gift with a notation that the “third party” is responsible for receipting them.

6. QPQ Gifts – if the donor received something of value for their contribution, maybe a CD or T-shirt, the QPQ value is indicated on the receipt. Use the QPQ Gift text to indicate that the amount of the item is reduced from their total contribution.

7. In Kind Gift – if you have a property donation where no value was assigned, these gifts are listed underneath the detail section of the statement. This text will be used as the header for the In Kind Gifts.

To enter the text you’d like displayed on the statement, do the following:
1. Click on the Receipt Text tab.
2. Click on the type of text you’d like to enter.
3. Enter the text and format it as appropriate.
4. The next window asks you to select the receipt format. First, second, third and forth quarter receipts display a summary of donations given within that quarter plus the donation detail.

To include the church name and address and/or donors name and address on the cover letter text, place your cursor in the position that you want a field, for example “addressed to”. Then choose that information from the Function drop down box on the lower section of the word processor.

**View People**

The view people tab is used to review the list of people that will be getting a statement. If you’d like to print a receipt for all these people, click PRINT RECEIPT. If you only want to print them for several of the people in the list, highlight the people that you want, then click PRINT RECEIPTS. It will only print statements for those people that were highlighted.

**Printing your receipt**

Once you have set up your criteria, reviewed the list of people and set up your text areas, click on PRINT RECEIPTS. The statements will be printed for everyone in the view people tab. If you want to print a receipt for everyone in the list simply highlight all the people, then click PRINT RECEIPT.
Canadian Receipts

The Canadian receipts are 1/3 page receipts. They can be printed 1 per page or in triplicate. They summarize the donations for previous year. There can be only one “original” receipt printed, each subsequent print has the word “copy” on it. There are three types of Canadian receipts:
1. Check or cash gifts
2. Cash gifts with advantage (Quid Pro Quo)
3. Non-cash or property gifts (In Kind gifts)

Printing Canadian receipts
To print Canadian receipts expand the Contributions menu. Click on Bulk Receipts. From criteria window select Canadian Receipts.

Select Period
1. Select the year for which you’ll be printing the receipts. Once you choose the year, the starting and ending dates will be filled in. These dates may be changed.

Print options
2. If you would like to print a sample receipt, mark the Sample box. This uses sample data. It is used primarily for lining up paper and viewing the format.
3. If you would like to use the receipt text, from Donations>Receipt Text, mark the Receipt Text box in the Print Options area.
4. Select either a single copy or triplicate within the Print Options box. If you select “single”, only one receipt will be printed for each donor. If you select triplicate, 3 receipts will be printed. One will be the “original”, the other 2 will be labeled “copy”.
5. Indicate the type of labels you’d like to print in the Print Option area. If you do not want to print labels, select none. If you are printing on labels that are 3 across and 10 down, select Avery 5160 labels. If you would like to create a custom size and format, select custom. See “Creating Custom Labels” for more details.
Sort options
6. If you would like to have the receipts printed in alphabetical order, select Last Name in the Sort options box. If you would like to print the receipts in postal code order, select Postal Code in the Sort Options box.

Reprint Options
7. Many times receipts must be re-printed for various reasons (they get lost, the printer jams, or they get lost in the mail). If you need a copy of a receipt that has already been printed, select “Reprint”. If you need a second “original”, select “Original”.
8. If you would like to print labels only, select the type of label from the Print Options area, then mark “Labels only”.

Data for the receipt
9. Enter the Name of the person authorized to sign the receipt.
10. Enter the Location at which it is issuing the receipt.

Once this information is entered, click PRINT RECEIPTS to print the receipts.
Individual Gifts

Individual gift receipts are receipts for a single contribution. To create these receipts, do the following:
1. Expand the Contributions menu.
2. Click on the Bulk Receipts menu item. The Contribution Receipts window will be displayed.
3. Choose Individual from the Receipt Type drop down.

Criteria

From this tab, you can choose the type of receipt you want and what information should be displayed on the report.

Enter the following information:
1. Year - Indicate the year that these receipts are for.
2. Quarter – Indicate the quarter for these receipts.
3. Period Starting - The date range for these receipts is typically 1 day.
4. Period Ending. The date range for these receipts is typically 1 day.
5. Total Giving for Period Over – If you only want to produce statements for folks who gave over a certain amount, enter that amount here.
6. Receipt Details – choose if you’d like the receipt to display only a grand total or if you’d like it to display totals by fund. You may also choose to list each individual gift.
7. Include Summary by Fund – If you selected Summary & Details under Receipt Details, you can mark this box if you’d like to display the summary information by fund.
8. Include Detailed Gifts – If you selected Summary & Details under Receipt Details, you can mark this box if you want to list each contribution for the period.
9. Single Print Job – under the print options section, mark this box if you want Roll Call to create 1 large print job that includes all the receipts. If you will be duplexing the print job (printing on both sides of the paper) you do not want to create a single print job. If you are using a large copier printer that requires a project code, you would want to check this box.
10. Cover Letter – if you’d like to print a cover letter before each statement, mark this box. Use the text tab to create your cover letter.
11. Print on Stationary - mark this box if you will be printing the statements on

Choose individual gift, and the date range.
Choose totals only, summary by fund and whether or not to list all contributions.
letterhead. By checking this box, the churches return address will not be printed on the statement. The statement will begin about 2 inches down the page.

12. Report In Kind giving – if you entered property or in-kind gifts without an associated amount and you want to display the item descriptions in the lower section of the receipt, mark this box.

13. Show Envelope Number – if you would like the envelope number printed on the statement, mark this box.

14. Sorted By – choose the sort order of the print job. Do you want the receipts sorted by zip code or by name?

15. Exclude – to exclude receipts for folks who have an address marked as “bad” or “do not send” mark this box.

Text

There are seven different types of “text” that can be used to customize your receipt. They are as follows:

1. Top Text – The top text area is used as a thank you note at the beginning of the statement. If you have a verse or a paragraph that you’d like printed at the beginning of the statement, use the top text area. If you have large thank you note, we recommend you use the cover letter section.

2. Cover Letter – The cover letter is a 1 page letter that will be printed before each statement.

3. Bottom Text – The bottom text area is used as footer text. It typically indicates no goods or services were received.

4. NonCashGifts – if the donor had any non-cash gifts where an amount was assigned to the gift, an asterisk will be placed beside the amount. Then at the bottom of the statement, there will be an asterisk with the verbiage you enter for non-cash gifts. Usually this would state that the donor is responsible for determining the fair market value of the gift.

5. Third Party Gift – if a donor gave a foundation monies to donate to your ministry on their behalf, the foundation is responsible for giving them a receipt. However, you would want to include the gift with a notation that the “third party” is responsible for receipting them.

6. QPQ Gifts – if the donor received something of value for their contribution, maybe a CD or T-shirt, the QPQ value is indicated on the receipt. Use the QPQ Gift text to indicate that the amount of the item is reduced from their total contribution.

7. In Kind Gift – if you have a property donation where no value was assigned, these gifts are listed underneath the detail section of the statement. This text will be used as the header for the In Kind Gifts.

To enter the text you’d like displayed on the statement, do the following:

1. Click on the Receipt Text tab.
2. Click on the type of text you’d like to enter.
3. Enter the text and format it as appropriate.
4. The next window asks you to select the receipt format. First, second, third and forth quarter receipts display a summary of donations given within that quarter plus the donation detail.

To include the church name and address and/or donors name and address on the cover letter text, place your cursor in the position that you want a field, for example “addressed to”. Then choose that information from the Function drop down box on the lower section of the word processor.
Top text area.

View People
The view people tab is used to review the list of people that will be getting a statement. If you’d like to print a receipt for all these people, click PRINT RECEIPT. If you only want to print them for several of the people in the list, highlight the people that you want, then click PRINT RECEIPTS. It will only print statements for those people that were highlighted.

Printing your receipt
Once you have set up your criteria, reviewed the list of people and set up your text areas, click on PRINT RECEIPTS. The statements will be printed for everyone in the view people tab that does not have Email checked. If you want to print a receipt for everyone in the list regardless of the Email status, simply highlight all the people, then click PRINT RECEIPT.

Statement for a Specific Person
To print a receipt for a specific individual, do the following:
1. Expand the Contributions menu.
2. Click on the Personal Receipts menu item. The Select a Person window will be displayed.
3. Enter the last name of the individual, select from the list or further refine by entering the first name.

Criteria
From this tab, you can choose the type of receipt you want and what information should be displayed on the report.

Enter the following information:
1. **Year**  - Indicate the year that these receipts are for.
2. **Quarter** – Indicate the quarter for these receipts.
3. **Period Starting** - The date range for these receipts is typically 1 day.
4. **Period Ending** - The date range for these receipts is typically 1 day.
5. **Total Giving for Period Over** – If you only want to produce statements for folks who gave over a certain amount, enter that amount here.
6. **Receipt Details** – choose if you’d like the receipt display only a grand total or if you’d like it to display totals by fund. You may also choose to list each individual gift.
7. **Include Summary by Fund** – If you selected Summary & Details under Receipt Details, you can mark this box if you’d like to display the summary information by fund.
8. **Include Detailed Gifts** – If you selected Summary & Details under Receipt Details, you can mark this box if you want to list each contribution for the period.
9. **Single Print Job** – under the print options section, mark this box if you want Roll Call to create 1 large print job that includes all the receipts. If you will be duplexing the print job (printing on both sides of the paper) you do not want to create a single print job. If you are emailing receipts you do not want to create a single print job. If you are using a large copier printer that requires a project code, you would want to check this box.
10. **Cover Letter** – if you’d like to print a cover letter before each statement, mark this box. Use the text tab to create your cover letter.
11. **Print on Stationary** - mark this box if you will be printing the statements on letterhead. By checking this box, the churches return address will not be printed on the statement. The statement will begin about 2 inches down the page.
12. **Report In Kind giving** – if you entered property or in-kind gifts without an associated amount and you want to display the item descriptions in the lower section of the receipt, mark this box.
13. **Show Envelope Number** – if you would like the envelope number printed on the statement, mark this box.
14. **Sorted By** – choose the sort order of the print job. Do you want the receipts sorted by zip code or by name?
15. **Exclude** – to exclude receipts for folks who have an address marked as “bad” or “do not send” mark this box.
Text

There are seven different types of “text” that can be used to customize your receipt. They are as follows:

1. Top Text – The top text area is used as a thank you note at the beginning of the statement. If you have a verse or a paragraph that you’d like printed at the beginning of the statement, use the top text area. If you have a large thank you note, we recommend you use the cover letter section.

2. Cover Letter – The cover letter is a 1 page letter that will be printed before each statement.

3. Bottom Text – The bottom text area is used as footer text. It typically indicates no goods or services were received.

4. NonCashGifts – if the donor had any non-cash gifts where an amount was assigned to the gift, an asterisk will be placed beside the amount. Then at the bottom of the statement, there will be an asterisk with the verbiage you enter for non-cash gifts. Usually this would state that the donor is responsible for determining the fair market value of the gift.

5. Third Party Gift – if a donor gave a foundation monies to donate to your ministry on their behalf, the foundation is responsible for giving them a receipt. However, you would want to include the gift with a notation that the “third party” is responsible for receipting them.

6. QPQ Gifts – if the donor received something of value for their contribution, maybe a CD or T-shirt, the QPQ value is indicated on the receipt. Use the QPQ Gift text to indicate that the amount of the item is reduced from their total contribution.

7. In Kind Gift – if you have a property donation where no value was assigned, these gifts are listed underneath the detail section of the statement. This text will be used as the header for the In Kind Gifts.

To enter the text you’d like displayed on the statement, do the following:

5. Click on the Receipt Text tab.
6. Click on the type of text you’d like to enter.
7. Enter the text and format it as appropriate.
8. The next window asks you to select the receipt format. First, second, third and forth quarter receipts display a summary of donations given within that quarter plus the donation detail.

To include the church name and address and/or donors name and address on the cover letter text, place your cursor in the position that you want a field, for example “addressed to”. Then choose that information from the Function drop down box on the lower section of the word processor.

Printing your receipt

Once you have set up your criteria, reviewed the list of people and set up your text areas, click on PRINT RECEIPTS. The statements will be printed for everyone in the view people tab that does not have Email checked. If you want to print a receipt for everyone in the list regardless of the Email status, simply highlight all the people, then click PRINT RECEIPT.
Married Couples filing Individually

By default, Roll Call will combine contributions for a Husband and Wife into one receipt. If the couple files separately and wants separate receipts, set the “files individually” setting in their profile.

1. Use Search Profiles to find the person who wants a separate receipt.
2. Click on the Contributions tab.
3. Click on the Settings tab.
4. Mark the option for “file individually”.

Note asterisk for non cash, qpq or third party gifts. The asterisk text is printed here.
CREATING CONTRIBUTION REPORTS

To run the standard donation reports,
1. Expand the Contributions menu and click Reports OR
2. Select Reports from the Top menu and select Contribution Reports.

From this Report window, all the reports are listed on the left side. There are also three tabs across the top: Criteria, Columns and View Records. The Criteria tab allows you to enter the date range and select who you want to include in the report as well as which funds to include in the report. The Columns tab allows you to choose what data or fields you want displayed on the report. The View Records shows you which people will be included in the report based on your criteria.

Donor Detail Report

The Donor Detail report outlines all donations for a given time period, for the funds you are interested in, for the people you are interested in. To run the Donor Detail report:
1. Expand the Contributions menu.
2. Click on Reports.
3. Click Donor Detail on the left sidebar.
4. Click on the Criteria tab. From the criteria tab, select the date range that you wish for this report. Then under the Who tab, select the donors you wish to see on the report. Do you wish to see all donors, or certain associations or certain groups, etc. Once you’ve chosen who, click on the What tab. From here, select the funds you are interested in.

Note the Criteria, Columns and View Records tabs.

All reports are listed on left side.

Select Contribution reports from top Reports menu.

Select reports under the Contribution menu on the Navigator.
interested in including on this report.

5. Click on the Columns tab. Choose the columns you wish to view on the report. There are default fields already set up for this report, but you can drag additional fields from the left side to the Selected column. You can rearrange the ordering in the Selected column by dragging and dropping in the order you wish to see them in the report.

6. If you’d like to change the sort order, move the columns from the Selected column to the “Sort” column.

7. Click GENERATE.

In our first example, let’s say we’d like a donor report for all donors (we don’t care what their association is) and we want to know all of their donations for all funds. On this report we want to see donor name, email address, donation date and amount.

1. Highlight Donor Detail on the left sidebar.
2. From the Criteria tab, select “This Week” from the date range drop down.
3. Click on the Who tab. Leave “Everyone” selected.
4. Mark the box for “Combine Families” if you want contributions from families lumped together.

5. Click on the What tab. Click the double arrow to move all funds to the Selected column.

6. Mark the box to include non-cash gifts if you want to include property gift amounts in the report as well.
7. Click on the Columns tab. Drag the email, address, city and state fields from the left side column to the Selected column on the report.
8. Click GENERATE to produce the report.

In this next example, lets say we’d like a donor report for all members who have given to the building fund. On this report we want to see donor name, address, donation date, fund and amount.

1. Highlight Donation Detail on the left sidebar.
2. From the Criteria tab, select “This Month” from the date range drop down.
3. Click on the Who tab. Select Association from the “Run for” drop down box. Click on Member to move that value to the Selected column.
4. Mark the box for “Combine Families” if you want contributions from families lumped together.
5. Click on the What tab. Click on Building to move that fund to the Selected column.
6. Mark the box to include non cash gifts if you want to include property gift amounts in the report as well.
7. Click on the Columns tab. Drag address, city and state fields from the left side column to the Selected column on the report.
8. Click GENERATE to produce the report.
Select Members as the folks you want in the report.

Select building fund as the fund to consider for the report.

Members who gave to the building fund.

**Donor Summary Report**

The Donor Summary report calculates the amount given by the donor for all the funds selected for the given time period. To run the Donation Summary report:

1. Expand the Contributions menu.
2. Click on Reports.
3. Click Donor Summary on the left sidebar.
4. Click on the Criteria tab. From the criteria tab, select the date range that you wish for this report. Then under the Who tab, select the donors you wish to see on the report.

Donor Summary Report

The Donor Summary report calculates the amount given by the donor for all the funds selected for the given time period. To run the Donation Summary report:

1. Expand the Contributions menu.
2. Click on Reports.
3. Click Donor Summary on the left sidebar.
4. Click on the Criteria tab. From the criteria tab, select the date range that you wish for this report. Then under the Who tab, select the donors you wish to see on the report.

110
report. Do you wish to see all donors, or certain associations or certain groups etc. Once you’ve chosen who, click on the What tab. From here, select the funds you are interested in including on this report.

5. Click on the Columns tab. Choose the columns you wish to view on the report. There are default fields already set up for this report, but you can drag additional fields from the left side to the Selected column. You can rearrange the ordering in the Selected column by dragging and dropping in the order you wish to see them in the report.

6. If you’d like to change the sort order, move the columns from the Selected column to the “Sort” column.

7. Click GENERATE.

In our first example, lets say we’d like a donor summary report for all donors and we want a total of all of their donations for the given time period. On this report we want to see donor name, email, total giving, and number of gifts.

1. Highlight Donor Summary on the left sidebar.
2. From the Criteria tab, select “This Quarter” from the date range drop down.
3. Click on the Who tab. Leave “Everyone” selected.
4. Mark the box for “Combine Families” if you want contributions from families lumped together.
5. Click on the What tab. Click the double arrow to move all funds to the Selected column.
6. Mark the box to include non cash gifts if you want to include property gift amounts in the report as well.
7. Click on the Columns tab. Drag the email field from the left side column to the
Selected column on the report.
8. Click GENERATE to produce the report.

In this next example, lets say we’d like a donor summary report for all members who have
given to the building fund. On this report we want to see donor name, address, total,
number of gifts and average gift.
1. Highlight Donor Summary on the left sidebar.
2. From the Criteria tab, select “This Month” from the date range drop down.
3. Click on the Who tab. Select Association from the “Run for” drop down box. Click
on Member to move that value to the Selected column.
4. Mark the box for “Combine Families” if you want contributions from families lumped
together.
5. Click on the What tab. Click on Building to move that fund to the Selected column.
6. Mark the box to include non cash gifts if you want to include property gift amounts in
the report as well.
7. Click on the Columns tab. Drag address, city and state fields from the left side
column to the Selected column on the report.
8. Click GENERATE to produce the report.
Donor Summary by Fund

The Donor Summary by Fund report calculates the amount given to each fund by the donor for the given time period. To run the Donor Summary by Fund report:

1. Expand the Contributions menu.
2. Click on Reports.
3. Click Donor Summary by Fund on the left sidebar.
4. Click on the Criteria tab. From the criteria tab, select the date range that you wish for this report. Then under the Who tab, select the donors you wish to see on the report. Do you wish to see all donors, or certain associations or certain groups etc. Once you’ve chosen who, click on the What tab. From here, select the funds you are interested in including on this report.
5. Click on the Columns tab. Choose the columns you wish to view on the report. There are default fields already set up for this report, but you can drag additional fields from the left side to the Selected column. You can rearrange the ordering in the Selected column by dragging and dropping in the order you wish to see them in the report.
6. If you’d like to change the sort order, move the columns from the Selected column to the “Sort” column.
7. Click GENERATE.

In our first example, lets say we’d like a donor summary by fund report for all donors and we want a total of all of their donations for the given time period. On this report we want to see donor name, email, amount, and number of gifts.

1. Highlight Donor Summary by Fund on the left sidebar.
2. From the Criteria tab, select “This Month” from the date range drop down.
3. Click on the Who tab. Leave “Everyone” selected.
4. Mark the box for “Combine Families” if you want contributions from families lumped together.
5. Click on the What tab. Click the double arrow to move all funds to the Selected column.
6. Mark the box to include non cash gifts if you want to include property gift amounts in the report as well.
7. Click on the Columns tab. Drag the email field from the left side column to the Selected column on the report.
8. Click GENERATE to produce the report.

Donor Giving by Week, Month or Year

The Donor Giving summarizes how much a donor gave by week, month or year in a spreadsheet format. The weeks, months or years are listed across the top of the spreadsheet for the time frame you selected.

To run this report:
1. Expand the Contributions menu.
2. Click on Reports.
3. Click Donor Giving on the left sidebar.
4. Click on the Criteria tab. From the criteria tab, select the date range that you wish for this report. Next, select the Report Type: by Week, by Month or by Year. Then under the Who tab, select the donors you wish to see on the report. Do you wish to see all donors, or certain associations or certain groups, etc. Once you've chosen who, click on the What tab. From here, select the funds you are interested in including on this report.
5. Click on the Columns tab. Choose the columns you wish to view on the report. There are default fields already set up for this report, but you can drag additional fields from the left side to the Selected column. You can rearrange the ordering in the Selected column by dragging and dropping in the order you wish to see them in the report.

6. If you’d like to change the sort order, move the columns from the Selected column to the “Sort” column.

7. Click GENERATE.

As an example, lets say we’d like a Donor Giving by Month report for all donors and we want a total of all of their donations for the given time period. On this report we want to see donor name, birthday and amount for each month.

1. Highlight Donor Giving on the left sidebar.
2. From the Criteria tab, select “This Month” from the date range drop down.
3. Click on the Who tab. Leave “Everyone” selected.
4. Mark the box for Combine Families if you want contributions from families lumped together.

5. If you want all people listed, whether or not they gave, uncheck Only Who Gave.
6. Click on the What tab. Click the double arrow to move all funds to the Selected column.
7. Mark the box to include non cash gifts if you want to include property gift amounts in the report as well.
8. Click on the Columns tab. Drag the birth date field from the left side column to the Selected column on the report.
9. Click GENERATE to produce the report.
In this example, let's say we'd like a Donor Giving by Week report for all members who have given to the building, missions and general fund. On this report we want to see donor name, association and total.

1. Highlight Donor Summary by Fund on the left sidebar.
2. From the Criteria tab, select “This Year” from the date range drop down.
3. Click on the Who tab. Select Association from the “Run for” drop down box. Click on Member to move that value to the Selected column.
4. Mark the box for “Combine Families” if you want contributions from families lumped together.
5. To list all Members regardless of giving, uncheck Only those who gave.
6. Click on the What tab. Click on Building, Missions, and General to move those funds to the Selected column.
7. Mark the box to include non cash gifts if you want to include property gift amounts in the report as well.
8. Click on the Columns tab. Drag address, city and state fields from the left side column to the Selected column on the report.
9. Click GENERATE to produce the report.
On the What tab, select the funds you wish to consider for the report.

Click over the columns or fields you wish to include on the report.

Click GENER- ATE to run the report.

Members who gave to the selected funds.

Giving by week for the date range selected.

Top Donors

The Top X Givers report lists the top givers based on the date range, funds and the people you select. To run this report:

To run this report:
1. Expand the Contributions menu.
2. Click on Reports.
3. Click Top X Donors on the left sidebar.
4. Click on the Criteria tab. From the criteria tab, select the date range that you wish
for this report. Then under the Who tab, select the donors you wish to see on the report. Do you wish to see all donors, or certain associations or certain groups etc. Once you’ve chosen who, click on the What tab. From here, select the funds you are interested in including on this report.

5. Click on the Columns tab. Choose the columns you wish to view on the report. There are default fields already set up for this report, but you can drag additional fields from the left side to the Selected column. You can rearrange the ordering in the Selected column by dragging and dropping in the order you wish to see them in the report.

6. If you’d like to change the sort order, move the columns from the Selected column to the “Sort” column.

7. Click GENERATE.

As an example, let’s say we’d like to view the Top 10 donors that are also members. On this report we want to see donor name, birthday and amount.

1. Highlight Top X Donors on the left sidebar.
2. From the Criteria tab, select “This Year” from the date range drop down.
3. Enter 10 as the number of givers.
4. Click on the Who tab. In the Run for drop down, select “Association”. Click on Member to move that value to the Selected column.
5. Mark the box for Combine Families if you want contributions from families lumped together.

Select date range to consider.

Select who you want to run this report for. In this example, we picked Member.

From the What tab, select the funds you are interested in including.
6. Click on the What tab. Click the double arrow to move all funds to the Selected column.
8. Mark the box to include non cash gifts if you want to include property gift amounts in the report as well.
9. Click on the Columns tab. Drag the birth date field from the left side column to the Selected column on the report.
10. Click GENERATE to produce the report.

Donors over X Amount

The Donors over X Amount report lists the donors that meet the specified amount criteria for the date range, funds and people selected.

To run this report:
1. Expand the Contributions menu.
2. Click on Reports.
3. Click Donors over X Amount on the left sidebar.
4. From the criteria tab, select the date range that you wish for this report.
5. Next enter the amount that you are searching for. The report will search for those folks who gave exactly that amount or greater over the date range.
6. Next under the Who tab, select the donors you wish to see on the report. Do you wish to see all donors, or certain associations or certain groups etc. Once you’ve chosen who, click on the What tab. From here, select the funds you are interested in including on this report.
7. Click on the Columns tab. Choose the columns you wish to view on the report. There are default fields already set up for this report, but you can drag additional fields from the left side to the Selected column. You can rearrange the ordering in the Selected column by dragging and dropping in the order you wish to see them in the report.
8. If you’d like to change the sort order, move the columns from the Selected column to the “Sort” column.
9. Click GENERATE.

As an example, lets say we’d like to view people who have given over $250 this year. We want to evaluate everyone in the database and we want to consider giving to all funds.

1. Highlight Donors over X amount on the left sidebar.
2. From the Criteria tab, select “This Year” from the date range drop down.
3. Enter 250 as the Amount.
5. Mark the box for Combine Families if you want contributions from families lumped together.
6. Click on the What tab. Click the double arrow to move all funds to the Selected column.
7. Mark the box to include non cash gifts if you want to include property gift amounts in the report as well.
8. Click on the Columns tab. Drag the address, city, and state fields from the left side column to the Selected column on the report.
9. Click GENERATE to produce the report.
Given X Times

The Given X Times lists the donors who have given over a certain number of gifts based on the date range, funds and people you select.

To run this report:
1. Expand the Contributions menu.
2. Click on Reports.
3. Click Given X Times on the left sidebar.
4. From the criteria tab, select the date range that you wish for this report.
5. Next enter the number of times you are searching for. The report will search for those folks who given at least that many times over the date range.
6. Next under the Who tab, select the donors you wish to see on the report. Do you wish to see all donors, or certain associations or certain groups, etc. Once you’ve chosen who, click on the What tab. From here, select the funds you wish to consider for this report.
7. Click on the Columns tab. Choose the columns you wish to view on the report.
     There are default fields already set up for this report, but you can drag additional fields from the left side to the Selected column. You can rearrange the ordering in the Selected column by dragging and dropping in the order you wish to see them in the report.
8. If you’d like to change the sort order, move the columns from the Selected column to the Sort column.
9. Click GENERATE.

As an example, lets say we’d like to view people who have given at least 6 times this year. We want to evaluate everyone in the database and we want to consider giving to all funds.

1. Highlight Given X times on the left sidebar.
2. From the Criteria tab, select “This Year” from the date range drop down.
3. Enter 6 as the Times.
5. Mark the box for Combine Families if you want contributions from families lumped together.
6. Click on the What tab. Click the double arrow to move all funds to the *Selected* column.
7. Mark the box to include non cash gifts if you want to include property gift amounts in the report as well.
8. Click on the Columns tab. Drag the address, city, and state fields from the left side column to the *Selected* column on the report.
9. Click GENERATE to produce the report.

**Given 0 Times**

The Given 0 Times report lists the people in your database who have not contributed within the specified time period.

To run this report:
1. Expand the Contributions menu.
2. Click on Reports.
3. Click Given 0 Times on the left sidebar.
4. From the criteria tab, select the date range that you wish for this report.
5. Next under the Who tab, select the donors you wish to see on the report. Do you wish to see all donors, or certain associations or certain groups, etc.
6. Click on the What tab. From here, select the funds you wish to consider for this report.
7. Click on the Columns tab. Choose the columns you wish to view on the report. There are default fields already set up for this report, but you can drag additional
fields from the left side to the *Selected* column. You can rearrange the ordering in the *Selected* column by dragging and dropping in the order you wish to see them in the report.

8. If you’d like to change the sort order, move the columns from the *Selected* column to the *Sort* column.

9. Click GENERATE.

As an example, let’s say we’d like to view members who have not given at all.

1. Highlight Given 0 times on the left sidebar.

2. From the Criteria tab, select “This Year” from the date range drop down.

3. Click on the Who tab. Select “Associations” as the Run for. Select Member.

4. Mark the box for *Combine Families* if you want contributions from families lumped together.

5. Click on the What tab. Click General fund to the *Selected* column.

6. Mark the box to include non cash gifts if you want to include property gift amounts in the report as well.

7. Click on the Columns tab. Drag the address, city, and state fields from the left side column to the *Selected* column on the report.

8. Click GENERATE to produce the report.
Listing of Members who have not given to the General fund.

Note actions that can be performed.

**Fund Summary**

The Fund Summary report calculates the amount given to the fund during the selected time frame by the selected donors. To run the Fund Summary report:

1. Expand the Contributions menu.
2. Click on Reports.
3. Click Fund Summary on the left sidebar.
4. From the criteria tab, select the date range that you wish for this report.
5. Next under the Who tab, select the donors you wish to see on the report. Do you wish to see all donors, or certain associations or certain groups etc.
6. Click on the What tab. From here, select the funds you wish to consider for this report.
7. Click on the Columns tab. Choose the columns you wish to view on the report. There are default fields already set up for this report, but you can drag additional fields from the left side to the Selected column. You can rearrange the ordering in the Selected column by dragging and dropping in the order you wish to see them in the report.
8. If you’d like to change the sort order, move the columns from the Selected column to the Sort column.
9. Click GENERATE.

As an example, let’s say we’d like to view how much has been given to General and Building by the small groups.

1. Highlight Fund Summary on the left sidebar.
2. From the Criteria tab, select “This Year” from the date range drop down.
3. Click on the Who tab. Select “Groups” as the Run for criteria. Click over all the small groups.
4. Mark the box for Combine Families if you want contributions from families lumped together.
5. Click on the What tab. Click General and Building funds to the Selected column.
6. Mark the box to include non cash gifts if you want to include property gift amounts in the report as well.
7. Click GENERATE to produce the report.
Select report period.

Select which donors should be included. In this example we are looking at giving from small group members.

From the What tab, select which funds you wish to include in the report.

Click GENER-ATE to run the report.

Listing of how much was given to the selected funds by members of the small groups.

**Fund Giving by Week, Month or Year**

The Giving by Fund by Week report summarizes all giving for the fund by week, month, or year for a given time period in a spreadsheet format. The weeks, months, or years are listed across the top.

To run this report:
1. Expand the Contributions menu.
2. Click on Reports.
3. Click Fund Giving on the left sidebar.
4. Click on the Criteria tab. From the criteria tab, select the date range that you wish for this report.
5. Next, select the Report Type: by Week, by Month, or by Year.
6. Then under the Who tab, select the donors you wish to see on the report. Do you wish to see all donors, or certain associations or certain groups, etc. Once you’ve chosen who, click on the What tab. From here, select the funds you are interested in including on this report.
7. Click on the Columns tab. Choose the columns you wish to view on the report. There are default fields already set up for this report, but you can drag additional fields from the left side to the Selected column. You can rearrange the ordering in the Selected column by dragging and dropping in the order you wish to see them in the report.
8. If you’d like to change the sort order, move the columns from the Selected column to the “Sort” column.
9. Click GENERATE.

As an example, lets say we’d like a Fund Giving by Month report for all donors and we want to include giving from Members and Regular Attenders.

1. Highlight Fund Giving on the left sidebar.
2. From the Criteria tab, select “This Year” from the date range drop down.
3. Select “by Month” as the Report Type.
4. Click on the Who tab and choose “Associations” as the Run for criteria. Click over Members and Regular Attenders to the Selected column.
5. Mark the box for Combine Families if you want contributions from families lumped together.
6. Click on the What tab. Click the double arrow to move all funds to the Selected column.
7. Mark the box to include non cash gifts if you want to include property gift amounts in the report as well.
8. Click GENERATE to produce the report.
From the What tab, select the funds you’d like to see in the report.

Click GENERATE to run the report.

Listing of Funds included.

Monthly totals of giving by Members or Regular Attenders.

Contribution Detail

The Contribution Detail report outlines all donations for a given time period, for the funds you are interested in, for the donors you select. To run the Contribution Detail report:

1. Expand the Contributions menu.
2. Click on Reports.
3. Click Contribution Detail on the left sidebar.
4. Click on the Criteria tab. From the criteria tab, select the date range that you wish for this report.
5. Then under the Who tab, select the donors you wish to include in the report. Once you’ve chose who, click on the What tab. From here, select the funds you are interested in including on this report.
6. Click on the Columns tab. Choose the columns you wish to view on the report. There are default fields already set up for this report, but you can drag additional fields from the left side to the Selected column. You can rearrange the ordering in the Selected column by dragging and dropping in the order you wish to see them in the report.
7. If you’d like to change the sort order, move the columns from the Selected column to the “Sort” column.
8. Click GENERATE.

In our first example, lets say we’d like a donor report for all donors (we don’t care what their association is) and we want to know all of their donations for all funds. On this report we want to see donor name, email address, donation date and amount.
1. Highlight Contribution Detail on the left sidebar.
2. From the Criteria tab, select “This Week” from the date range drop down.
3. Click on the Who tab. Leave “Everyone” selected.
4. Click on the What tab. Click the double arrow to move all funds to the Selected column.
5. Mark the box to include non cash gifts if you want to include property gift amounts in the report as well.
6. Click on the Columns tab. Drag the fields from the left side column to the Selected column on the report.
7. Click GENERATE to produce the report.
Contribution Statistics

The Contribution Statistics report breaks down donations by age range, association and zip code, marital status and giving range. This file also outlines the number of givers by range of giving. To run the Donation Statistics report:

1. Expand the Contributions menu.
2. Click on Reports.
3. Click Contribution Statistics on the left sidebar.
4. Click on the Criteria tab. From the criteria tab, select the date range that you wish for this report.
5. Then under the Who tab, select the donors you wish to include in the report. Once you’ve chose who, click on the What tab. From here, select the funds you are interested in including on this report.
6. Click GENERATE.

In this example, let’s run the statistics for all donors for this year and let’s consider all funds.

1. Highlight Contribution Statistics on the left sidebar.
2. From the Criteria tab, select “This Year” from the date range drop down.
3. Click on the Who tab. Leave “Everyone” selected.
4. Click on the What tab. Click the double arrow to move all funds to the Selected column.
5. Click GENERATE to produce the report.
First Time Donors

The First Time Donor report lists the folks who have given for the first time within the reporting period for the funds you select. To run this report:

To run this report:
1. Expand the Contributions menu.
2. Click on Reports.
3. Click First Time Donors on the left sidebar.
4. Click on the Criteria tab. From the criteria tab, select the date range that you wish for this report.
5. Select the Times Given (First time, Second Time, etc.)
6. Then under the Who tab, select the donors you wish to see on the report. Do you wish to see all donors, or certain associations or certain groups, etc. Once you’ve chosen who, click on the What tab. From here, select the funds you are interested in including on this report.
5. Click on the Columns tab. Choose the columns you wish to view on the report. There are default fields already set up for this report, but you can drag additional fields from the left side to the Selected column. You can rearrange the ordering in the Selected column by dragging and dropping in the order you wish to see them in the report.
6. If you’d like to change the sort order, move the columns from the Selected column to the “Sort” column.
7. Click GENERATE.

As an example, let’s say we’d like to view our first time donors that are also members. On this report we want to see donor name, address, city and state.

1. Highlight First Time Donors on the left sidebar.
2. From the Criteria tab, select “Last Week” from the date range drop down.
3. Enter First Time as the Times Given.
4. Click on the Who tab. In the Run for drop down, select “Association”. Click on Member to move that value to the Selected column.
5. Mark the box for Combine Families if you want contributions from families lumped together.
6. Click on the What tab. Click the double arrow to move all funds to the Selected column.
7. Mark the box to include non cash gifts if you want to include property gift amounts in the report as well.
8. Click on the Columns tab. Drag the birth date field from the left side column to the Selected column on the report.
9. Click GENERATE to produce the report.

Highlight First Time Donors.

Select report period.

Choose who want want to consider. In this example we are looking for Members who gave for the first time last week.

Choose the funds you want to consider. In this example we are looking for people who gave to any fund.

From the Columns tab, choose the fields you wish to see on the report.
CREATING STANDARD AND CUSTOM LABELS

Standard Labels

There are several ways that you can produce mailing labels for people in your system. You can do it from the search windows or from the Reports & Labels menu option. To create the mailing labels, do the following:

1. Click the LABELS icon from the search window, or choose the Labels menu under the Reports and Labels menu item.
2. If you choose the Labels menu item, you’ll need to determine who you want to create the labels for in the criteria tab. If you used the ICON from the search screen, Roll Call will produce mailing labels based on the list or the highlighted people in your list.
3. Click on the Customize tab to change the font, size of font. You can also use the adjustment areas to move the positioning of the printing on the label.
4. Click PRINT to send the labels to the printer.
Criteria
If you selected the Labels menu item, under the Reports & Labels menu, you will be brought into the Criteria tab to start the process. Use the “Run For” drop down to choose who you want to print the labels for. Once you’ve chosen your type, select the specific values you’d like returned. To select, double click on the value and it will move to the right side “Selected” box.

Options
If you clicked on the LABELS icon from a search screen, you will be anchored on the options tab. In this section you will be able to choose to create a mailing label for each individual in the list, or one mailing label per family in the list. You can also choose to use their first name or to use their title to address the label.

You may also opt to exclude people who have an address that is marked as “bad” or who have indicated “do not send” mail.

The default sort for the labels is by Last Name, First Name. If you’d like to change that to postal code or to envelope number, make that selection on the options tab.
Choose which information to include on the label.

Choose font, size and type for printing.

Use arrows to adjust printing start position.

**Customize**

Use the Customize tab to change the font, type and size of the lettering for your label. You may also add static text to the label, or eliminate the use of Address Line 2 on the label.

If you have a partial sheet of labels, use the area in the upper right to indicate the label number to start with. Also, if you need to adjust where the printing starts, use the adjustment arrows to move to the top, left or right, or up or down.

**View Records**

If you’d like to review who will have a label printed click the View Records tab. Each person that will have a label printed will be listed.

**Custom Labels**

If the standard labels in Roll Call do not meet your needs, use the Custom Label writer to customize your format. The Label writer is a tool provided with the 4D database that Roll Call is written on. This chapter outlines the basic usage of the Label writer within the context of Roll Call.

When creating a custom label you’ll need to determine several things:
1. What “set” of people should have a label?
2. What fields do I want in the label?
3. How do I want the information sorted?

**Which People**

To begin customizing a label:
1. Expand the Report & Labels menu on the left side of the navigator window.
2. Click on the Labels menu.
3. Highlight your base table.
4. Click on the ADD icon.
Once you’ve clicked ADD LABEL the query editor is produced so that you may select the people. For a detailed description of using the query editor, see “Using the Query Editor”.

For this example, let’s create a label for all the people who are Members.

1. Select “People” as the **Query In** table.
2. Select “Association” as the **Field Name**.
3. Highlight “is equal to” in the **Comparison** box.
4. Enter “Member” as the **Value**.
Place the Fields on the Label

Now that you have the data (the people that will be included), you must determine what information you want on the label. From the list of fields, highlight the field you want, then drag it to the label template to the right.

For this example, let’s create a label with the standard name and address.
1. Highlight First Name and drag it to the template.
2. Highlight Last Name and drag it on top of First Name. This will concatenate the two fields.
3. Click on the plus sign (+) or the arrow in front of Family Info. This will open up the address fields.
4. Highlight Address 1 and drag it to the label template under the first and last name.
5. Highlight City and drag it under the Address1 field.
6. Highlight State and drag it on top of City.
7. Highlight Zip and drag it on top of State.
8. To align the fields on the left, click on each field while holding down the shift key. This should place boxes that indicate the row is selected. When everything is selected press the ALIGN LEFT icon.
9. To evenly space between the rows of information, leave all fields selected and press the SPACING icon.
10. To change the font and font size, leave all the fields selected and change the font from the drop down box in the lower text area.
**Static text**
Enter the text you’d like on the label in the Static Text field underneath the list of fields. Then click on the arrow above the field to move the text to the label template. Once the text is on the label template you may drag it around, change the font and size.

**Change Label Format and Size**
Click on the layout tab in the Label editor. This tab allows you to select the number of labels per sheet, the size of the labels, and the horizontal and vertical gap between labels.
Print the Labels
To send the labels to the printer, press the PRINT button. The print dialog box will be displayed, so you may choose your printer.

Re-use the Label Template
Once you’ve created the label template, you’ll want to save it, so it can be used again. The template is made up of the fields, static text and the formatting options that were selected. Press the SAVE button. A file dialog box is displayed. Give the label a name that is meaningful to you. Once you close the label editor window, you’ll see it listed in the Tables and Templates window.

To print the labels again, expand the Reports & Labels menu. Click on the Labels menu, highlight the label you’d like to run. Then press the GENERATE icon. The query editor will be displayed, so you can select the data you want in the label. A print dialog box will be displayed, so you can send the labels to the printer.

Modify a Label Template
To edit the label, expand the Reports & Labels menu on the left side. Click on the Labels menu. Double click on the template you’d like to edit. The query editor will be displayed, so you can select the people you need labels for.

A message will be displayed, telling you the name and location of the template file. Remember this information. Once you are in the label editor window, press the LOAD button. A file dialog box is displayed. Navigate to the template file from the message, highlight it, then press OPEN. The columns and formatting will be displayed in the label editor window.

Make any changes you’d like to the columns or formatting on the label template. To print the labels, press the PRINT button. If you’d like to save the changes, press SAVE.
**PRINTING DIRECTORIES**

There are four types of directories available in Roll Call.

1. **Classic** - This directory is a two column directory, that includes all family member names, address and home phone.
2. **Standard** - This directory allows the user much more flexibility in choosing the font, size and what information to display.
3. **Picture** - This directory contains the families picture, family member’s name and phone number.
4. **Group** - This directory contains information on folks in a specific group or class.

**Classic Directory**

To create the Classic Directory, expand the Directories menu on the left side bar. Click on Classic Directory. The first window that is displayed asks if you’d like a certain association marked with an asterisk. For example, if you’d like all your members to have an asterisk by their name, click “Yes”. You may also decide if you’d like the current, primary or both addresses to be printed in the directory. After you’ve made your selections, press OK.

The next window that is displayed is asking for what people you want in the directory. To indicate specific associations to be included in the directory, click over each association to be included, over to the Include box. For example, if you’d like to include members and regular attenders in the directory, click on the association “Member” from the Select List box. It will move over to the Include box. Next click on “Regular Attender” from the Select List box. It will move over to the Include Box. Click the PRINT DIRECTORY button.

Once you’ve selected the associations, click here to create the directory.

When you select an association it will be moved to this column.

Click on each association that you’d like included in the directory.

Select the association you’d like marked with an asterisk.

Select addresses to be included in directory.

To mark a certain association with an asterisk, click Yes.
Standard Directory

To create the Standard Directory, expand the Directories menu on the left side. Then click on Standard.

Select the fields and format that will be displayed
The first window that is displayed allows you to customize what information you’d like to include in the directory.
1. The first item asks if you’d like a certain association marked with an asterisk. For example, if you’d like all your members to have an asterisk by their name, select “Member” from the drop down list and click Yes.
2. The next section asks which address you’d like included. You may select Current, Primary or Both addresses to be printed in the directory.
3. *Show Birth Dates* should be checked if you’d like the family member’s birth dates to be included in the directory.

4. *Show Children’s Ages* should be checked if you’d like this information listed.

5. *Show Wedding Date* should be checked to include this information.

6. *Show Associations* should be checked if you’d like each family member’s association to be displayed.

7. *Show Shepherd Area* should be checked if you’d like the families “shepherd” to be included in the directory.

8. *Show Family Email* should be checked if you’d like the family email to be listed.

9. This directory may be printed in a *Two or Three Column* format. Click on the format you’d like.

10. The *Font* and *Font Size* may be selected.

11. In the *Personal Phone* numbers section, click on each of the phone number types you’d like included in the directory. Click on the type to move it over to the *Include* box.

If you will be sending this directory to your printer, click on the PRINTER button. If you’d like to save this directory as a file, click on the SAVE TO DISK button.

---

**Select the people using associations**

The next window that is displayed is asking which people you want to include in the directory. To indicate specific associations that should be included in the directory, click over each association, over to the *Include* box. For example, if you’d like to include members and regular attenders in the directory, click on the association “Member” from the *Select List* box. It will move over to the *Include* box. Next click on “Regular attender” from the *Select List* box. It will move over to the *Include* box.

Click the PRINT DIRECTORY button. If you opted to send the directory to the Printer, please note this will go directly to your default printer. If you chose to save the directory to disk, you will be asked to provide a file name.
Select the people using the query editor
If you would like to determine who is placed in the directory by another criteria, you can use the Query Editor. For example, let’s say you only want those folks that live in a certain city to be included in the directory. From this window, click the USE QUERY button. The Query Editor will be displayed.
1. Change the Query In field to Address.
2. Select City from the Field Name drop down box.
3. Highlight “is equal to” in the Comparison box.
4. Enter the name of the city in the Value field.
5. Click on the QUERY button.

If you opted to send the directory to the Printer, please note this will go directly to your default printer. If you chose to save the directory to disk, you will be asked to provide a file name.
Example of Standard Directory

Family Picture Directory

To create the picture directory, expand the Directories menu on the left side bar. Click on Family Picture.

Select the people using associations

The next window that is displayed is asking which people you want to include in the directory. To indicate specific associations that should be included in the directory, click over each association, over to the Include box. For example, if you’d like to include members and regular attenders in the directory, click on the association “Member” from the Select List box. It will move over to the Include box. Next click on “Regular attender” from the Select List box. It will move over to the Include box.

Click the USE ASSOCIATIONS button.
Specify formatting options
The next window allows you to select the Font and Font Size for the text. You may also indicate if you’d like only those families with pictures or all families selected from the above criteria. You may also check if you’d like the Address, Phone and Email included. After you’ve made your selections, press CONTINUE.

Next your print dialog boxes will be displayed so you can print your directory.

Select the people using the query editor
If you would like to determine who is placed in the directory by another criteria, you can use the Query Editor. For example, lets say you only want those folks that live in a certain city to be included in the directory. From this window, click the USE QUERY button. The Query Editor will be displayed.
1. Change the Query In field to Address.
2. Select City from the Field Name drop down box.
3. Highlight “is equal to” in the Comparison box.
4. Enter the name of the city in the Value field.
5. Click on the QUERY button.
Example of Family Picture Directory
USING THE QUERY EDITOR

Query Editor uses
The query editor is used to produce lists of records that have common characteristics. Some examples are:
- A list of all the members.
- A list of the people who visited last Sunday. (Not available in RC Lite.)
- A list of the groups that meet on Wednesday night. (Not available in RC Lite.)
- A list of donations given between two dates.

Table Layouts
Before using the query editor it is helpful to understand how information is stored in Roll Call. Roll Call is based on the relational database 4D. The information is stored in tables. Each table contains information about a “thing”. For example: people, addresses, and donations. Each table then is related to each other. For example, each donation must be for a person. A more complete listing of tables and all fields is located in Appendix A.

Address
The address table contains the family specific information. Some of the fields in the address table are: Family number, Family email address, Address 1, Address 2, City, State, Zip, Area Code 1, Phone 1, Area Code 2, Phone 2, Alternate Address, Shepherd Area and Wedding Date.

People
The people table contains the individual’s information. Some of the fields in the people table are: Family ID, Title, First Name, Nick Name, Middle Name, Last Name, Gender, Birthday, Age, Association, email address and envelope number. The individual’s “standard” (work, fax, pager and cell) phone numbers are stored in this table. The values for the custom fields that were defined by your church are stored in the people table. Summary donation information is stored in the people table. There are summary fields for the donation amounts given 4 years ago, 3 years ago, 2 years ago, last year and YTD.

Donations
The donations table contains the high level information about a donation. Some of the fields in the donation table are: Person who gave the donation, the donation date, the donation amount, the type of donation, the check number, property gift information and quid pro quo donation amount.

Designation
The designation table indicates which fund the donation was assigned to. If the donation was split into multiple funds, there will be multiple designation records for that donation. The designation fields are: the ID of the related donation record, the fund designation, the amount given to that fund, and the pledge ID if the designation was for a pledge fund.

Non-Cast Gift
The non-cash gift table indicates what was given, the donor, and the amount it was sold for.
Sets

A set is a grouping of records. Each time you execute a query a set of records displayed. Once you have the list or “set” you may save it.

To save a set, press the SAVE SET button. A file dialog box will be displayed allowing you to choose the location and to name the file. After you’ve entered this information press SAVE.

Now this set can be used for multiple tasks. For example, let’s say you are creating a merge letter to people that have donated to a certain fund. You need to give the pastor a list of those people, you need to create the merge letter and you need to create labels for that group of people. Those are 3 different tasks, but all with the same “set” of people. You could do the query once, save the set, then re-use the set for each of the tasks. PLEASE NOTE: the set is only a snapshot of who has given to a fund at that particular time. The set does not change as more people give to that fund.

To call up the “set”, you may use the GET SET button any time you are at a query editor window with the same Find Records In table name. You may also click on the GET SET icon from the Summary screen. If your set was for people records then the Find Records In must also be for people. If the set you saved was Donation records, the Find Records In must be for Donations.

Current selection

Roll Call stores the results of the last query performed in memory. You can always recall those results by clicking the CURRENT SELECTION button from the query editor.

For this example, let’s say you did a query then accidentally clicked on the CANCEL button from the results screen. You could go back to the query editor and press the CURRENT SELECTION button to retrieve your results.

Basic Query

To query you’ll need to fill in the following information:
1. The table you’ll be querying from. For example, if the criteria is the City, you’ll be querying from the Address table. Enter this in the Query In portion of the query.
editor.
2. The field name. In that same example, if the criteria is City, you’ll need to select City from the Field Name drop down box.
3. The comparison. In this example the comparison would be “is equal to”. Highlight that in the Comparison box.
4. The value. Enter the name of the city you are interested in, in the Value field.
5. Press the QUERY button. A list of all the people who live in that city will be returned.

Multiple criteria query
Let’s say you want to know all the people that are over 30 years old that are members. We’ll have two lines in this query.

1. Expand the People menu. Click on Search Profiles. Click QUERY icon.
2. Enter People as the Query In table. (Both association and year to date are stored in the people table)
3. Select “Age” from the Field Name drop down box.
4. Highlight “is greater than” in the Comparison box.
5. Select 30” as the Value.
6. Press the ADD LINE button.
7. Select “Association” from the Field Name drop down box.
8. Highlight “is equal to” from the Comparison box.
9. Enter Member as the Value.
10. Press QUERY. A list of folks over 30 who are members will be displayed.

A partial name criteria
In this example we’ll use a wildcard character. The wildcard in Roll Call is the @ symbol. Let’s say we want to find all the people whose first name begins with KIM.

1. Expand the People menu. Click on Search Profiles. Click QUERY icon.
2. Enter “People” as the Query In table. (first name is stored in the People table)
3. Select “First Name” from the Field Name drop down box.
4. Highlight “is equal to” in the Comparison box.
5. Enter “KIM@” as the Value.
6. Press QUERY. A list of people with the first name of Kim or Kimmy or Kimberly etc. will be returned.

**Complex Queries**

**Association plus other criteria**

In this example, let’s find all the people that are members, regular attenders and their zip code is 61010
1. Select People>People Summary from the main menu, then click on the SEARCH icon..
2. Click on the Associations tab and click over Member and Regular Attender
3. Click on the Editor tab.
4. Select Address as the table.
5. Select City in the Field drop down

Change table to Addresses.

Select Field Name City.

Enter value you are looking for.

Press QUERY to execute.

Enter criteria values.

Click QUERY to execute query.

Click ADD LINE to add additional criteria to the query.
**Associations query**

Let’s say you want to know all the people that are Members or Regular Attenders. In this example, we’ll need to use the Associations tab of the query editor.

1. Expand the People menu. Click on Search Profiles. Click QUERY icon.
2. Click on the Associations tab.
3. Click on each Association you want to include in the query.
4. Press QUERY to execute the query.

**An either/or criteria**

In this example, let’s say we need a list of all the people who live in a certain city OR they are assigned to a specific shepherd area.

1. Expand the People menu. Click on Search Profiles. Click QUERY icon.
2. Enter “Address” as the Query In table. (both city and shepherd area are stored in the address table)
3. Select “City” from the Field Name drop down box.
4. Highlight “is equal to” in the Comparison box.
5. Enter “Byron” as the Value.
6. Press the ADD LINE button.

Select OR if they don’t have to meet both criteria.
By using the “greater than” and “less than” comparison operators we can look at a date range.
**Multi-Table query**

You may need a list, in which the criteria spans several tables. For example, give me all the people who have donated since 2009 who live in Byron.

1. Expand the People menu. Click on Search Profiles. Click QUERY icon.
2. Enter “Donation” as the Query In table. (donation date is stored in the Donations table)
3. Select “Donation Date” from the Field Name drop down box.
4. Highlight “is greater than or equal to” in the Comparison box.
5. Enter 1/1/09 as the Value.
6. Press the ADD LINE button.
7. Change the Query In table from “Donations” to “Addresses”.
8. Select “City” from the Field Name drop down box.
9. Highlight “is equal to” in the Comparison box.
10. Enter “Byron” in the Value field.
11. Press QUERY. A list of people gave after 1/1/06 a who live in Evergreen is returned.

By using the wildcard character, we can find all the people that are enrolled in Childrens group.

**Query in Current Selection**

Querying within a current selection allows you to limit your query to only those records that are in the current selection. Let’s say you’ve just done a query of all the people who are Members. Then you want to know who has given in the last 6 months.

From the results list, press the SEARCH icon. The query editor is displayed again.

1. Select Donation as the “Query In” table.
2. Select “Donation Date” from the Field Name drop down box.
3. Highlight “is greater than” from the Comparison box.
4. Enter 1/1/11 in the Value field.
5. Press QUERY CURRENT SELECTION. This will reduce your first list of Members that have given since 1/1/11.

**Query with a combination of AND and OR**

Some queries require the use of the connector AND as well as the connector OR. When
Click on the Associations tab.

Click on each Association you’d like to include.

Click on Editor tab.

Select the field and criteria values.

Click query to get the results of the criteria from both tabs. Association and editor.
using both And and OR remember to place the OR statements first. An example of this type of query would be, give me a list of all the children or youth who have been baptized. I have Baptized as a custom check box field.
1. Select People>Summary from the main menu and click the SEARCH icon.
2. Leave People as the Query In table.
3. Select “Family Position” from the Field Name drop down box.
4. Highlight “is equal to” in the Comparison box.
5. Select “Child” as the Value.
6. Press the ADD LINE button.
7. Press the OR button. Notice the AND is changed to OR on the second line.
8. Select “Family Position” from the Field Name drop down box.
9. Highlight “is equal to” from the Comparison box.
10. Select “Youth” as the Value.
11. Press the ADD LINE button.
12. Select “Baptized” from the Field Name drop down box.
13. Enter True Value.
14. Press QUERY. A list of all children and youth who have been Baptized is displayed.

Query using Except
For this example let’s say we want to find all people who live in Byron, but not on Staff. In this example Staff is an Association.
1. Select People>Query from the main menu.
2. Leave “People” as the Query In table.
3. Select “City” from the Field Name drop down box.
4. Highlight “is equal to” from the Comparison box.
5. Enter Byron.
6. Click the ADD LINE BUTTON.
7. Click the EXCEPT button. The AND changes to EXCEPT.
8. Select “Association” from the Field Name drop down box.
9. Highlight “is equal to” from the Comparison box.
10. Select “Staff” as the Value.
When using a combination of OR’s and AND’s in your criteria, make sure to put the ORs first.

Results from our first query.

To perform additional queries on these results, click the SEARCH icon.

To perform the query against ONLY the records from the previous query, click the QUERY CURRENT SELECTION button.
11. Press QUERY. A list of people that aren’t on staff, who live in Byron is displayed.

Comparing two result sets
There are several ways that you can compare two sets:

An intersection compares the results of two queries and returns the records that were common to both sets. For example, I want a list of all the people who have donated and are enrolled in a group.

A union combines the results of two queries. An example of the union is – give me a list of people who either donated or joined a group.

A difference would subtract out the records that were common to both sets. An example of the difference is – give me all the people who donated but are not in a group.

For these examples, let’s look at all the people in our database that have donated in the last year. Then let’s compare that to the list of people that belong to a small group.

For the first query:
1. Select People>People Summary from the main menu, then click SEARCH icon.
2. Change the Query In table to “Donations”.
3. Select “Donation Date” from the Field Name drop down box.
4. Highlight “is greater than” from the Comparison box.
5. Enter the earliest date of donations to consider, for example 1/1/06.
6. Press QUERY. A list of people who gave to the church on or after 1/1/06 is displayed.

From the results list, press the SELECT button. This brings up the screen that allows you to perform the intersections, unions and differences. In the left box labeled Set A, mark the button for Current Selection then press the button GET SET A. Now SET A contains all the people who have donated since 1/1/06.

Next, let’s move over to the box labeled Set B. Click on the button for Query Editor, and press the button GET SET B. The query editor is displayed.
1. Change the Query In table to Group “Membership” (not available in RC Lite).
2. A window is displayed allowing you to select a specific group. Press the CANCEL button here. We want all groups for this example.
3. Select “Group Name” from the Field Name drop down box.
4. Highlight “is equal to” in the Comparison box.
5. Enter the wild card character @ (this tells Roll Call we want any group).
6. Press QUERY. The people who are in a group are in SET B.

Next, click the button to Combine Sets, if you’d like to see the “union” of the two sets. That is, the combination of the people who gave and the people who are in a group. Press the OK button to see the results of the intersection.

Click Subtract B from A, if you’d like to see the “difference” between the two sets. This would show you all the people that gave but are not enrolled in a group. Press OK to see the results of this difference.

Click Subtract A from B, if you’d like to see the “difference” between the two sets. This difference would give you the people that are in a group, but have not donated. Press OK to see the results of this difference.

Click the button to Common to A and B, if you’d like to see the “intersection” of the two sets. That is, the people that have both donated and belong to a group. Press the OK button to see the results of the intersection.

**AND, OR and EXCEPT**

“Or” increases the possible results by allowing more ways for records to be selected. “And” restricts the possible results by compounding the requirements. “Except” restricts results by introducing exceptions or exemptions. If you need to use more than one of these conjunctions, place the OR statements first, then the AND statements, then the EXCEPT.

**Save a Query**

Let’s say you do a query of Members, Regular Attenders and Occasional Attenders on a regular basis. To save the query text, press the SAVE QUERY button. A file dialog box...
asks for the location to save and the name of the file. Enter this information, then press SAVE.

To use the query later, press the LOAD QUERY button from the query editor. A file dialog box is displayed. Navigate to the file you saved previously. The query text is displayed in the query editor. Press the query button to execute the query.

**Special Query**

There are some searches that require more complex algorithms. These searches have been “pre-set” for you to use. From the results list of a query, click on the SPECIAL icon.

**Change Selection to Head**

This search can only be done from within a results list. It will reduce the list to include only the Heads of Family for each family that was represented in the list. For this example let’s say we had a list of the children from our first grade class. If we choose to change to the heads of family, the children will not be in the list anymore, only the head of their family will be listed.

**Change Selection to Mothers**

This search can only be done from within a results list. It will change the list to include the Mothers for each family that was represented in the list. For this example let’s say we had a list of the children from our first grade class. If we choose to change to the Mothers, the children will not be in the list anymore, only the Moms will be listed.

**Change Selection to Fathers**

This search can only be done from within a results list. It will change the list to include the fathers for each family that was represented in the list. For this example let’s say we had a list of the children from our first grade class. If we choose to change to the fathers, the children will not be in the list anymore, only the dads will be listed.

**Change Selection to Adult and all Children**

This search can only be done from within a results list. It will change the list to include an adult and all the children of each family that was represented in the list. For this example let’s say we had a list of the children from our first grade class. If we choose to change to the adult and all children, the husband, wife or adult from the family plus all the children in the family will be displayed in the list.

**Find Single Parents**

This search finds the single parents.
Find Keywords

Keywords allow you to classify people by interests, giftings etc. To search for all the people that have certain interests, talents or gifts – use this special query. Once you click OK from the special search window, a key word query editor will be displayed.

1. Click on the appropriate *Key Word Field*.
2. Highlight “is equal to” in the *Comparison* box.
3. Enter the value of the key word you are searching for, for example “Mechanic”.
4. Press QUERY to get a list of all the people who are categorized as Mechanics.

To specify more than one key word, use the ADD LINE button and repeat the process. For more information on multi-line queries, see the section in this chapter on creating basic queries.

Find possible blended families

This search looks for families with more than two members, where at least one person has a different last name.

Find people with picture

This search looks for individuals who have a picture in Roll Call.

Find families with a picture

This search looks for families that have a picture in Roll Call.

Find possible uninvolved families

This search allows you to specify the type of “uninvolvment”. When you select this search, the uninvolved window is displayed.

You may check one or all of these boxes. If you select multiples, an AND conjunction is used.

If you check the box for “hasn’t given”, you may also specify a since date. For example, I want to know what families have not given since the beginning of the year. I would check “hasn’t given”, then enter 1/1/06 as the date.

If you check the box for “hasn’t attended” (not available in RC Lite) – this will tell you what families haven’t attended any event (worship service or group/class) in the last year.

If you check the box for “hasn’t joined group” (not available in RC Lite) – this will tell you what families haven’t recently (based on the since date) joined a group.

If you check the box for “haven’t had their record modified” – this will tell you which families have not had any of their demographic information changed since the date you specify.
Check the appropriate criteria for “uninvolved”.

- Haven’t given
- Haven’t attended
- Haven’t joined a group/class
- Haven’t had record modified

Since: 04/30/95
CREATING CUSTOM REPORTS

If the standard reports in Roll Call do not meet your needs, use the Quick Report writer to create custom reports. The Quick Report editor is a tool provided with the 4D database that Roll Call is written on. This chapter outlines the basic usage of the Quick Report editor within the context of Roll Call.

To create a Quick Report you’ll need to determine several things:
1. What table should the report be based on. That is, what is the report about, people, donations, groups etc.?  
2. What “set” of information should be included in the report?  
3. What columns or fields do I want in the report?  
4. How do I want the information sorted?  
5. Are there any calculations required in the report?

Create a custom report
To create a Quick Report follow these main steps.
1. Select Reports>Quick Reports from the top menu.  
2. Click on the reports tab.  
3. Click the ADD icon.  
4. Perform the query to determine what data should be included in the report.  
5. Format the report.  
6. Generate the report.

Base Table
Each Quick Report must be based on a table. The report can contain values from multiple
tables, however, the table which contains the lowest level of information must be the “base” table. For example, if we want a report with People’s name, Address, Donation and Designation information, Designation would be the “base” table. If we wanted a report with Group information as well as the members in the group, Group Membership would be the base table.

To begin creating the report, expand the Reports&Labels menu on the left side. Select Quick Reports. Select the base table from the left sidebar. Click on the green plus sign or ADD icon. Next you’ll be prompted with the query editor to determine what records should be included in the report.

**Data for the Report**

Once you’ve clicked the ADD icon the query editor is produced so that you may select the data you’d like included in the report. For a detailed description of using the query editor, see “Using the Query Editor”.

For this example, let’s create a report of all the people who have donated over $100.

From the Query Editor, change the Query In table to Donations. In the Field drop down, select Amount. In the Comparison box, choose “is greater than”. In the Value field, enter 250. Press the QUERY button.

**Select columns for the report**

Now that you have the data (the people that will be included), you must determine what information you want to see about each of those people. From the Quick Report editor,

You may select a column by double clicking on it. In this example, notice the list of people fields under Master Table.

To create a report with First Name, Last Name, Address, City, State, and Zip Code, double click on the First Name field, then the Last Name field. Once you double click on the field name, a column will be created in the upper part of the quick report editor for that field.
Next, use the drop down box to change *Master Table* to *Related Tables*. You should see a box to the left of Family Info on Windows or an arrow to the left of Family Info on the Mac. Click on that box/arrow. The list of Address fields will be displayed below. Double click on *Address, City, State, Zip* etc. to include them in the report.

**Calculated columns**

To create a column that uses a formula, select Column>Add from the Quick Report menu. The formula editor is displayed. The formula editor allows you to combine the values of multiple fields, return certain values such as YES/NO instead of TRUE/FALSE, perform mathematical equations and use pre-written functions.

When you select (double click) on a field, it is placed in this report writer area.

Double click on fields to include it in the report.

**Concatenation**

To combine the values of multiple fields into one column, you can use the plus sign in the formula editor. Common examples of combining field values would be to have the last name, a comma, then the first name, or combining the area code and phone number.
For this example, let’s create a name column. Double click on the Last Name field found under the box Related Tables. The name [People]LastName is placed in the formula editor box. Next click on the plus sign. Next enter a quote mark, a comma, a space then another quote mark. Next click on the plus sign again. Now double click on the First Name in the section below Related Tables. The formula should read:

[People]LastName", "+[People]FirstName

Click the OK button to accept the formula.

**Equations**

You can perform mathematical equations within the formula editor. You can add, subtract, multiply, divide and create percentages. For this example, let’s say we wanted to add a person’s total giving this year and last year’s amount.

Double click on the Year to Date field found under the box Related Tables. The name [People]Year to Date is placed in the formula editor box. Next click on the plus sign. Now double click on the Last Year field in the section below Related Tables. The formula should read:

[People]YeartoDate+[People]LastYear

Click the OK button to accept the formula.

**NUM function**

The num function allows you to return a constant, based on a field value. This comes in very handy for Boolean or check box type fields where the value is either True or False. By using the NUM function you could choose to return an X if the value was True or you could return Yes if it was True and No if it was False.

For this example, let’s assume we have a custom check box called Newsletter. In our report, we want to return an X if the person wants to receive the newsletter. The formula is:

(Num([People]Newsletter)*"X")

If you wanted to return a Yes or No, the formula would be:

((Num([People]Newsletter=True)*"Yes")+(Num([People]Newsletter=True)*"No")
Roll Call functions

The following functions can be typed into the formula editor, or selected from the commands by theme box to the right. Scroll down to reach the functions in italics. Double click to select the function you need.

DoBuild_Label – this function returns an address block for an individual. It contains the name and current address.

Jim_Sue_Label – returns an address block using the first name of the head of family plus the spouse name and the last name, then the address.

Family_Label – returns “Mr. & Mrs.” Plus the first and last name of the head of family, then the address.

Different_Last_Name – returns an address block with the first and last name of the head of family plus the first and last name of the spouse (if the last name is different).

Get Many -> People -> Group Membership – returns a list of all groups that the person is involved in.

Get Many -> People -> Pledge funds – returns a list of all the pledge funds this person has pledged to.

Get Many -> People -> Pledges – returns a list of all the amounts a person has pledged.

List_Phones (“All”) - Produces a list of the “non-standard” individual phone numbers that are stored in the telephone table.

List_Family(““) Returns a list of all the family members.

Get Children(0) – Returns a list of the children for a family.

Build_Salutation – Returns the head of the family’s nickname plus the spouse’s first name.

Get DES Function(TRUE) – Returns a list of donations to the current pledge record.

Get DES Function (FALSE) – Returns the total of donations to the current pledge record.

Designation SUM – Returns the total for the designations.

Summary Information

You can use the sum, average, minimum, maximum and count functions for a column. For this example, let’s say we have a report that lists donation information for a date range and we want the grand total donated as well as the number of donations given.

1. In the cell where donation amount and grand total intersect, click on the SUM icon (backwards E) or select Cells>Sum from the quick report menu.
2. In the cell where name and grand total intersect, click on the COUNT icon (N) or select Cells>Count from the quick report menu.
Sort the Report

To sort the report by a specific column, highlight the field name. Next, press the green arrow to the right, to move the field to the sort order box. For example, let’s say we have a report that lists people information and we want it sorted by name. First highlight Last Name and press the green arrow. Last Name is now listed in the sort order box. Then if you’d like to sort by First Name within the same Last name, highlight First Name, and press the green arrow.

Notice the field name changed row that is created for each sort criteria.

Format the Report

There are several formatting options in the report writer. These allow you to EDIT the titles, page breaks, whether to display detail lines, and the presentation of the report.

Titles

To set up the title of your report, select File>Headers and Footers from the quick report menu. Enter the text you’d like for your title in the appropriate text box.
Page breaks
To create a page break, you must have sorted your report on a certain field. Then you can create a page break, each time the value of that field changes. For example, let’s say we created a report that lists all donations for a given year. We wanted to sort those donations by the fund that they were designated to. Then we want a new page for the different funds.

When you sorted the report by designation, a new line or row is created in the spreadsheet called Designation changed. Right mouse click on that title and select Totals Spacing. The subtotals properties window is displayed. Click on the button for Generate Page Break.

Hide details
To create a summary report you will need to hide detail lines. For example, let’s say you want a donation report by fund designation. You only want totals for the designation, not every individual donation.
Output presentations
There are several things that can be done to change the appearance of the report.
1. Page Setup
2. Fonts
3. Presentation

To change the orientation of the report from portrait to landscape, select File>Page Setup from the quick report menu. Choose the appropriate orientation.

You may change the font or the font size for a row, column or specific cell. Highlight the area you wish to change, then select the font style in size from the drop down boxes in the middle top of the window.

To modify the presentation of the report you can:
1. Select Style>Borders to modify the types of border included in the report.
2. Select Style>Presentation to pick a certain presentation.
3. Select Style>Right/Left Justify to change the justification of a column.

Print the Report

To send the report to the printer, select File>Generate. The print dialog box will be displayed, so you may choose your printer. If you’d like to save the report to a file, select File>Destination. Change the destination to a Disk File. Then select File>Generate from the menu. A file dialog box will be displayed so that you can save this report as a tab delimited text file. These types of files can easily be imported into 3rd party programs such as a spreadsheet.

Re-use the Report

Once you’ve created the report, you’ll want to save the template so it can be used again. The template is the columns and the formatting options that were selected. Select File>Save from the quick report menu. You’ll be asked for a file name and location. Give the report a name that is meaningful to you. Once you close the quick report editor window, you’ll see the report listed in the Tables and Templates window.
To run the report again, select Reports>Quick Reports from the top menu. From the Tables and Template window, highlight the report you’d like to run. Then press the GENERATE icon. The query editor will be displayed, so you can select the data you want in the report. A print dialog box will be displayed, so you can send the report to the printer.

Edit a Saved Template

To edit the report, select Reports>Quick Reports and Labels from the main menu. From the Tables and Template window, double click on the template you’d like to modify. The query editor will be displayed, so you can select the data you want to see in the report. After you review the raw data, press the EDIT icon.

A message will be displayed, telling you the name and location of the template file. Remember this information. Once you are in the quick report window, select File>Open from the report writer window. Then navigate the template file from the message, highlight it and press SAVE. The columns and formatting will be displayed in the quick report window.

Make any changes you’d like to the columns or formatting on the report template. To run the report select File>Generate. If you’d like to save the changes, press File>Save.
CLEANING UP THE DATA – DATA ADMINISTRATION

List of Valid Values
Most lists can be changed. The “lists” are the valid values that you can enter for a field such as Association, Key Words, Custom Field Lists, City, Telephone Types, etc.

To modify this information, expand the Administration menu and click on Lists. A screen with all the lists will be displayed.

Click on the list you’d like to modify.

List of all the “valid value” lists.

Click the plus sign to add a value, click minus to delete an item.

From this window, click on the type of list you’d like to modify. The current list of values will be displayed on the right. To add a new value, press the plus sign. A line will open up for you to add the value. To delete a value, highlight it, then press the minus sign. To modify a value, double click on the value, then make necessary changes.

Duplicate Check
To identify potential duplicate records, expand the people menu. Click on Find Duplicate Records. The area to the right will allow you to select your duplicate criteria.

To see all the people that have the same first and last name, click the First and Last Name button. To see all the people that have the same address but are in different families, click on the Same Address option. To see all the folks with the same home number, click on the option for Home Phone.

From the display of potential duplicates, click on a person that appears to be a duplicate record, then click on the next record that appears to be a duplicate with the first. These records will be placed side by side so you can view the information.

From the buttons underneath each record, you may perform several actions:
1. Click the DISPLAY button to view the person’s entire record.
2. Click the TRANSFERS button to transfer the donations from one record to the other.
3. Click the TRANSFER button to transfer other details such as visitations, group membership and comments.
4. Once you’ve viewed and transferred information as required, you may delete the unwanted duplicate record.
Click on Find Duplicate Records.

Choose how you’d like to find the duplicate records.

Display of a persons information.

Use these buttons to transfer information and delete records.

The list of potential duplications. Click on name to view it on the right side.

Bulk Changes

Many of the people and group fields can be changed “en masse”. For example if you wanted to change a city name from from St. Thomas to Saint Thomas, you can use the bulk changes area.

Global change to people or address information

As an example, let’s say that you want to change all people that have an Association of Member to a new Association of “Partner”. To do this:

1. Expand the People menu.
2. Click on Bulk Changes.
3. Use the “Run For” area to select you want to make this change to. In this example, select Associations, then click over Member.
4. Next select the column you will be changing. In this example it is Association.
5. Enter the new value for the Association.
MAINTAINING THE DATABASE

Data File Location
The data file contains all the information that you have entered in Roll Call. Since this file contains all your work, make sure you know the name and location of it and that you back it up regularly.

The data file is comprised of two files: the 4D data file and the 4D resource file. The 4D data file name will end with the extension 4DD. The resource file will end with the extension 4DR. The name and location of your data file is found by selecting Help> About Roll Call.

User Security

Activate Security
To activate the security system in Roll Call you will need to give Director a password. Once Director has a password, you will be required to log into Roll Call with a valid user name and password.

To give Director a password, expand the Administration menu. Click on User Security. Click on Director form the list on the left. Click on the CHANGE PASSWORD button. Enter a password.
Preferences

There are password preferences you can set for your system. The preferences allow you to select how often a person needs to change their password, if a password is required, how many characters the password needs to be, etc.

To set the preferences:
1. Expand the Administration menu.
2. Click on User Security.
3. Click on the Prefs icon (right side).
4. Enter the Maximum Password Age. If you do not want passwords to expire, mark the option for “Passwords Never Expire”. If you want the passwords to expire after a certain length of time, mark the option for “Expires In” and indicate how long.
5. Enter the Minimum Password Age. If you don’t care how often the user changes their password, you can mark the option for “Allow Changes Immediately”. If you only want them to be able to change so often, mark the option for “Expires In” then enter the number of days.
6. Enter the Minimum Password Length. If you wish to allow blank passwords, mark the option to “Allow Blank”. Otherwise, enter the “At Least” number of characters.

Create New User

To create a new user:
1. Expand the Administration menu.
2. Click on User Security.
3. Click on the plus sign in the lower left under the user names.
4. Enter the user name for this user.
5. Enter a default password.
6. Indicate if this will be a standard user or a check in user. Standard users will see the Navigator window when the sign in. Check In users will see the check in screen when they log in.
7. Click OK to save that user.
8. Next mark the security levels that are appropriate for this user.

Security Levels
The following are the security levels for a standard users.

<table>
<thead>
<tr>
<th>Security Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read Only</td>
<td>If this box is checked, a user will have read only privileges for the areas marked.</td>
</tr>
<tr>
<td>People</td>
<td>If this box is marked, the user can view, enter and delete people information</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Groups</td>
<td>This allows the user to view, enter and delete groups. (Not available in RC Lite)</td>
</tr>
<tr>
<td>Services</td>
<td>This allows the user to view, enter and delete worship services. (Not available in RC Lite)</td>
</tr>
<tr>
<td>Contributions</td>
<td>This allows the user to view, enter and delete contributions.</td>
</tr>
<tr>
<td>Contributions Plus</td>
<td>This allows the user to post and reverse batches. They can also transfer contributions.</td>
</tr>
<tr>
<td>Pledges</td>
<td>This allows the user to view, enter and delete pledges. (Not available in RC Lite)</td>
</tr>
<tr>
<td>Letters</td>
<td>Allows this user to access the word processor portion of roll call. (Not available in RC Lite)</td>
</tr>
<tr>
<td>Visitation</td>
<td>Allows this user to view, enter and delete visitation information. (Not available in RC Lite)</td>
</tr>
<tr>
<td>Background Checks</td>
<td>Allows the user to view, enter and delete background check information. (Not available in RC Lite)</td>
</tr>
<tr>
<td>Attendance</td>
<td>Allows the user to view, record, modify and delete attendance information. (Not available in RC Lite)</td>
</tr>
<tr>
<td>Graduation</td>
<td>Allows the user to set up graduation profiles and to do the graduation. (Not available in RC Lite)</td>
</tr>
<tr>
<td>Expert</td>
<td>Allows the user to do the duplicate check check, access preferences, child check in set up preferences and bulk changes</td>
</tr>
<tr>
<td>Confidential Comments</td>
<td>Allows the user to view, enter and delete confidential comments. (Not available in RC Lite)</td>
</tr>
<tr>
<td>Custody Comments</td>
<td>Allows the user to view, enter and delete custody comments. (Not available in RC Lite)</td>
</tr>
<tr>
<td>Email</td>
<td>Allows the user to email from Roll Call. (Not available in RC Lite)</td>
</tr>
<tr>
<td>Edit Lists</td>
<td>Allows the user to create, modify and delete list of values. For example, Associations, Cities, and Keywords.</td>
</tr>
<tr>
<td>Assign Id’s</td>
<td>Allows the user to enter family numbers and badge number.</td>
</tr>
<tr>
<td>People Import</td>
<td>Allows the user to import people into the system.</td>
</tr>
<tr>
<td>People Export</td>
<td>Allows the user to export people information to a tab delimited file.</td>
</tr>
</tbody>
</table>
Click on the BACKUP icon.

Click PREFERENCES to select backup location and or to set a backup schedule.

Click to perform backup.

Click on Configuration to indicate where to put the backup.

Click here to browse your system to select backup location.
Backup a networked system

On the network, the backup can be done on the server or from the client. To backup from the Server, click on Maintenance from the Server dashboard. Next click START BACKUP. To perform a backup from one of the clients, select Help>Administration window. This will display the Server dashboard and you can do the backup as if you were at the Server.

Recover the database

You can recover from a backup from within the Roll Call menus, or from your operation system.

From within Roll Call

To recover from a backup, select File>Backup from the main menu. Click on the RESTORE icon on the left. Highlight the backup file, then click RESTORE.
From the operating system
If you cannot get into Roll Call, you can open a backup file, by double clicking on the Roll Call icon, then immediately holding down the ALT key. The window displayed will allow you to restore a backup.

1. Select the option to “Restore a Backup”
2. Navigate to and highlight your backup file. Click OPEN.
3. From the next window Click RESTORE.

Select Restore a backup.

From the Server dashboard, click on Maintenance.
To set backup preferences, location, and frequency, click on Maintenance and click the PREFERENCES button. When you are anchored on the Configuration link on the left, you may set up the backup location. Make sure you backup both the data file and structure file. Also, if your church imports family or individual pictures make sure to also backup the Images folder under Roll Call Server.
Select your backup frequency and starting time.

Indicate how many backups to retain.

How do you want to handle backup failures?

Indicate how to handle backups if there are active transactions.
Recover database from a backup on a network system

To recover from a backup, open Roll Call Server and immediately hold down the ALT/OPTION key to get the open file dialog box. Choose the option for Restore from Backup. Click OK. Navigate to your latest backup file. Highlight it and click OPEN. Your compiled database and data file will be recovered. Next you can restart Roll Call Server.
Open a Different Datafile

To open a different data file, double click on the Roll Call or Roll Call Server icon, then immediately hold down the ALT key. Choose the option for opening a different data file.

Compact the data file

Compacting your data removes any fragmentation within your data file. The process of compacting is slightly different depending on whether or not you use a stand-alone or server system.

Single user system
1. Select File>Backup from the main menu.
2. Click on the icon for COMPACT on the left.
3. Click on the top icon for Compact data and indexes.

Roll Call Server
1. Make sure all clients are disconnected from Roll Call.
2. From the Server dashboard, click on Maintenance.
3. Click COMPACT DATA.
Repair my data file

To repair your data file, follow these steps.

1. Double click on the Roll Call or Roll Call Server icon, then immediately hold down the ALT key.
2. Choose the option for Maintenance window.
3. Click on the REPAIR icon on the left.
4. Click the REPAIR button.
Choose the option for Maintenance.

Click on the REPAIR icon.

Click here to repair the data file.
Index

A
Add records 16
Allergy Information 30
Anniversary
  report 55
Association 24, 141

B
Background Check
  report 60
Base Table 161
Batch 64
  post 71
  reports 72
Batches
  reverse 84
Birthday 24
  home page 12
  report 54
Blended family 159

C
Calculated Columns 163
Canadian Receipts 99
Cash or Check 65
Chart of Accounts
  giving funds 63
Check Reader 71
Church Address 17
Classic Directory 139
Comments
  allergy 30
  confidential 30
  custody information 30
  general 30
  special needs 30
Compare two sets 156
Concatenation 163
Confirm Data Report 56
Connect to different data file 182
Contributions
  find by batch 79
Contribution Detail Report 127
Contributions
  add to existing batch 83
  correct 83, 85
  delete 87
  enter new 65
  find by person 76
  in-kind 69
  non-cash 69
  property 69
  qpq, quid pro quo 67
  split 67
  transfer 85
Contribution Statements
  annual 96
  Canadian 99
  for a specific person 103
  formats 89
  individual gift 101
  married, filing separately 106
  quarterly 92
  quarterly tabular 95
Contribution Statistics 129
Current Selection 147
Custody Information 30
Custom
  dates, people 28
  fields, people 27
  reports 161
Customize
  mailing labels 134
  my reports 60
  receipt text 93
  search window 15, 40
  statement text 93
Custom report 161–169
  hide details 167
  page break 167
  print 168
  save as file 168
  select columns 162
  select data 162
  sort 166
  titles 166

D
Data file
  location 172
  open different 182
  repair 183–184
Delete
  contributions 87
  people 36
Delete Records 16
Deposit Slip 75
Designation. See also Giving Fund
Directory 139–145
Post Batch 71
Preferences
  application level 17
  search window fields 15

Q
Quarterly Statement 92
tabular 95
Query 146–160
  across tables 152
  editor 146–160
  search 42
  search criteria 147–148
  sets 146
  special 158–160
Quickbooks 72
Quick report 161–169
Quid Pro Quo 67

R
Repair data file 183
Report Output Window 48
Reports
  batch 72
  columns 47
  contribution 107
  criteria 46
  output window 48
  report selection window 45
  run for 46
  run, generate 47
  view records 47
Reverse Batch 84

S
Saved reports 60
Search
  find by 39
  people 39
Search Window 41
Security 172
Server
  install 9
  recover 181
  repair 182
Sets 146, 147, 156
Shepherd area 24
Significant Dates 28
  report 56
Single parents
  find 158
Single user system
  connect to different data file 182
  install 8
  recover 177
Special Needs 30
Special queries 158
Spiritual Gifts 29

Standalone
  connect to a different data file 182
  install 8
  recover 177
Standard Directory 140

T
Tables 146
Tag People 43
Tag People
  tag 44
  view 44
Talents 29
Tax Receipts. See also Contribution Statements
Template
  label 138
  report 169
To Do List 12
Top Donor Report 117
Transfer
  donations 36

U
Uninvolved families 159
Uninvolved Family Report 59
Unlisted phone 24
User Security 172

V
Visitations
  view from people 29
Visitor
  list on home page 13